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บทสรุป 

 ปัจจุบนั ท่ีมีการน าระบบ Business Intelligence มาใชม้ากข้ึน เพื่อช่วยเหลือในการตดัสินใจในการ
บริหารต่าง ๆ ส่งผลใหมี้การพฒันาซอฟตแ์วร์ข้ึนมามากมาย ดงันั้นความรู้เก่ียวกบัผลิตภณัฑต่์าง ๆ ท่ี
เก่ียวขอ้ง จึงเป็นเร่ืองท่ีจ าเป็น ผูจ้ดัท าโครงงานจึงไดรั้บมอบหมายใหศึ้กษา DataStage® ซ่ึงเป็นหน่ึงใน
เคร่ืองมือท่ีใชใ้นการท า Business Intelligence ซ่ึงใชใ้นการแปรรูปขอ้มูล นอกจากน้ี DataStage® ยงัรองรับ
การท า ELT ซ่ึงเป็นเทคนิคการแปรรูปขอ้มูลท่ีพฒันามาจากการท า ETL เน่ืองจากพฒันาการของ Hardware 
ต่าง ๆ ซ่ึงมีขอ้ดีในการยอ้นหาตน้ทางของขอ้มูลไดง่้ายกวา่ ETL จึงท าให ้DataStage® เป็นอีกหน่ึงโปรแกรม 
ท่ีน่าศึกษา เพื่อรองรับการให้บริการแก่ลูกคา้ภายในอนาคต 

 จากการด าเนินงานจดัท าระบบจ าลองนั้น ไดพ้บวา่ Stage ต่าง ๆ ท่ีมีใหใ้ชน้ั้น มีปริมาณท่ีมาก ท าให้
ไม่สามารถจะจดัท าคู่มือฉบบัสมบูรณ์ได ้ จึงเนน้ไปท่ี Stage ท่ีมีแนวโนม้จะไดใ้ชง้านบ่อย ๆ นอกจากน้ีใน
การใชง้านบาง Stage นั้น จ าเป็นตอ้งมี Library File แต่บางไฟลก์็ไม่สามารถหามาติดตั้งได ้ท าใหไ้ม่สามารถ
จ าลองวธีิการใชง้านได ้ผูจ้ดัท าโครงงานจึงเปล่ียนไปใช ้Stage อ่ืนท่ีมีลกัษณะการใชง้านท่ีคลา้ยคลึงกนั 
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Summary 

 Nowadays, the Business Intelligence implementation is demanded by many businesses to support 
the managers’ decision. There are many developers trying to meet with the demand of Business Intelligence 
software, thus there are many tools developed to gain the market share. As a company that provides the 
Business Intelligence implementation, the knowledge about Business Intelligence software is crucial for the 
company. DataStage® is one of the software applied to extract the information from data to use with the 
Business Intelligence later. The DataStage® also supports extraction methods such ETL and ELT. 

 While creating the demonstration, there are a lot of stages to work on, so this document covers 

only important stages and DataStage® signature stages. There are some stages that need library files in 

order to work, but the files are no longer published or distributed, therefore the substitute stage is selected 

and presented in this report instead.  
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กติตกิรรมประกาศ 

ในการท่ีขา้พเจา้ไดม้าสหกิจศึกษา ณ บริษทั เอ-โฮสต ์จ ากดั ซ่ึงเป็นความร่วมมือระหวา่งทางบริษทั
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สามารถน าส่ิงต่าง ๆ เหล่านั้น มาใช้พฒันาทกัษะของตนเอง ส าหรับรายงานการปฏิบติังานสหกิจศึกษาใน
คร้ังน้ี สามารถส าเร็จลุล่วงไดด้ว้ยดีจากความร่วมมือและการสนบัสนุนจากหลายฝ่ายดงัน้ี 
 1.คุณบุญประสิทธ์ิ ตั้งชยัสุข ท่ีเห็นความส าคญัของการสหกิจศึกษา และไดใ้ห้โอกาสท่ีมีคุณค่ายิ่ง 
แก่ขา้พเจา้ในการเขา้มาสหกิจศึกษาท่ีบริษทัแห่งน้ี 
 2.คุณสุชัย เย็นฤดี ท่ีได้จดัการฝึกอบรมให้ความรู้ก่อนปฏิบติัสหกิจ เพื่อฝึกความพร้อมก่อนการ
ท างานและใหค้  าแนะน าความรู้ต่างๆ ตลอดระยะเวลาท่ีปฏิบติังานสหกิจศึกษา 
 3.คุณระพีพฒัน์ ธนะพฒัน์, คุณปาริชาติ ทองดอนน้อย (พนกังานท่ีปรึกษา) ท่ีไดใ้ห้ความกรุณารับ
ขา้พเจา้เขา้มาเป็นส่วนหน่ึงของแผนก Academy and BI ในการปฏิบติังานสหกิจศึกษาในคร้ังน้ี รวมทั้งให้
ค  าปรึกษาและค าแนะน าเก่ียวกบัความรู้หรือการท างานต่าง ๆ 
 4.อาจารย์ ดร. สะพร่ังสิทธ์ิ มฤทุสาธร อาจารย์ท่ีปรึกษา ท่ีได้ให้ความช่วยเหลือในด้านต่าง ๆ 
ระหวา่งท าสหกิจ ไม่วา่จะเป็นการถ่ายทอดความรู้ และการให้ค  าแนะน าในดา้นต่าง ๆ ตลอดระยะเวลาท่ีได้
ปฏิบติัสหกิจศึกษา จวบจนกระทัง่เสร็จส้ินกระบวนการสหกิจศึกษา 
 5.อาจารย ์อมรพนัธ์ ชมกล่ิน ประธานสหกิจศึกษาประจ าสาขาวิชาเทคโนโลยีสารสนเทศ ท่ีไดช่้วย
เตรียมความพร้อมในด้านต่าง ๆ ก่อนเร่ิมการปฏิบัติสหกิจศึกษา และได้ช่วยให้ค  าปรึกษาในขั้นตอน
กระบวนการต่าง ๆ ของสหกิจศึกษาเป็นอยา่งดี 
 และทุกคนในแผนก Academy and BI รวมไปถึงบุคลากรของสถาบนัเทคโนโลยีไทย-ญ่ีปุ่น และ
บุคคลท่านอ่ืน ๆ ท่ีมิไดก้ล่าวนามท่ีไดใ้ห้ค  าแนะน าช่วยเหลือในการปฏิบติังานสหกิจและจดัท ารายงานฉบบั
น้ีใหส้ าเร็จไปไดด้ว้ยดี ขอขอบคุณ ไว ้ณ ท่ีน้ี 
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บทที ่ 1  
บทน า 

ในบทน้ีจะกล่าวถึงการแนะน าสถานประกอบการในดา้นต่าง ๆ ต าแหน่งและหน้าท่ีท่ีผูจ้ดัท า
โครงงานไดรั้บ รวมไปถึงวตัถุประสงคข์องโครงงาน และค าศพัทต่์าง ๆ ท่ีไดใ้ชใ้นโครงงานฉบบัน้ี 

1.1 ช่ือและทีต่ั้งของสถานประกอบการ [1] 
 

ช่ือหน่วยงาน บริษทั เอ-โฮสต ์จ ากดั (A-HOST Company Limited)  

ทีต่ั้ง เลขท่ี 979/53-55 ชั้น 21  อาคารSM Tower  ถนนพหลโยธิน  แขวงสามเสนใน  เขตพญาไท    
   กรุงเทพมหานคร  10400 (ดูแผนท่ีประกอบไดใ้นรูปท่ี 1.1) 

โทรศัพท์ 02-298-0625 - 32  

แฟกซ์ 02-298-0053  

เวบ็ไซต์ http://www.a-host.co.th  

อเีมล Marketing@a-host.co.th     

 

รูปที ่1. 1 สถานท่ีตั้ง บริษัท เอ-โฮสต์ จ ากัด *1 
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1.2 ลกัษณะธุรกจิของสถานประกอบการ หรือการให้บริการหลกัขององค์กร 
 

บริษทั เอ-โฮสต ์ จ ากดั ไดก่้อตั้งข้ึนในปี พ.ศ. 2542 เป็นหน่ึงในผูน้ าดา้นการจดจ าหน่ายผลิตภณัฑ์
ซอฟตแ์วร์และบริการระบบเทคโนโลยสีารสนเทศในองคก์รแบบครบวงจร โดยเฉพาะ การใหบ้ริการแอพ
พลิเคชนัแบบโฮสติง (Hosting) หรือ ASP (Application Service Provider) บริการดูแลระบบ ณ สถานท่ีของ
ลูกคา้ (IT Outsourcing) รวมถึงบริการใหค้  าปรึกษาและจดัวางระบบดว้ยแอพพลิเคชนัส าหรับการวางแผน
บริหารจดัการทรัพยากรองคก์ร (Enterprise Resource Planning : ERP) ของ Oracle ซ่ึงครอบคลุมทั้งองคก์ร
ขนาดใหญ่ องคก์รขนาดกลางและขนาดเล็ก ทั้งน้ีทางบริษทัยงัไดรั้บการแต่งตั้งจาก Oracle ใหด้ าเนินกิจการ
โฮสติงในส่วนของระบบ Oracle Application เป็นรายแรกในประเทศไทยมาตั้งแต่ พ.ศ. 2542 

ในการด าเนินธุรกิจของเอ-โฮสตต์ลอดระยะเวลา 10 ปี ไม่เพียงแต่ในฐานะผูบุ้กเบิกธุรกิจโฮสติงและ
ธุรกิจการให ้บริการแอพพลิเคชนัในรูปแบบ ASP เท่านั้น แต่เอ-โฮสตย์งัไดท้  าการติดตั้งระบบไอที รวมทั้ง
ผลิตภณัฑข์อง Oracle ใหก้บัลูกคา้จนประสบความส าเร็จมาแลว้เป็นจ านวนมาก ซ่ึงหลายรายเป็นหน่ึงในร้อย
บริษทัชั้นน าของประเทศไทย แต่ท่ีส าคญักวา่นั้น ก็คือการท่ี เอ-โฮสต ์ ไดก้ลายเป็นพนัธมิตรทางธุรกิจอยา่ง
แนบแน่นจนกลายเป็นหุ้นส่วนทางกลยทุธ์และเป็นผูส้นบัสนุนส าคญัท่ีมีส่วนช่วยผลกัดนัใหธุ้รกิจของลูกคา้
เติบโตสู่ความส าเร็จ 

ปัจจุบนัเอ-โฮสตเ์ป็นหน่ึงในบริษทัลูกของบริษทั ดรากอ้นวนั จ ากดั ซ่ึงเป็นบริษทัมหาชน ท่ีอยูใ่นตลาด
หลกัทรัพยแ์ห่งประเทศไทย  

เป็นเวลากวา่ 10 ปีท่ีเอ-โฮสต ์และ Oracle ไดด้ าเนินธุรกิจร่วมกนัอยา่งใกลชิ้ด และ ถือเป็นพนัธมิตรทาง
ธุรกิจกนัมานบัตั้งแต่ก่อตั้งบริษทัปีพ.ศ.2542 จวบจนกระทัง่ในปัจจุบนัดว้ยความมุ่งมัน่ในการน าเสนอ
ผลิตภณัฑข์อง Oracle ผา่นการให ้บริการแอพพลิเคชนัในรูปแบบของ ASP ในฐานะท่ีเอ-โฮสตเ์ป็นผูบุ้กเบิก
ธุรกิจดงักล่าว  และเพิ่มศกัยภาพในการด าเนินธุรกิจของลูกคา้ไดอ้ยา่งเตม็ประสิทธิภาพและเหมาะสม ท าให้
ไดรั้บรางวลัแห่งความส าเร็จและไดรั้บการยกยอ่งมาอยา่งต่อเน่ือง  

ทางเอ-โฮสต ์  มีทกัษะการท างานและการบริการท่ีครอบคลุมเทคโนโลยชีั้นสูงของ Oracle และไดรั้บ
การแต่งตั้งใหเ้ป็น OCAP (Oracle Certified Advantage Partner) รายแรกในไทย ซ่ึงเป็นระดบัสูงสุดของ 



3 
 
Oracle ท่ีมีใหก้บับริษทัคู่คา้ในปี พ.ศ. 2547 และต่อมาในปี พ.ศ. 2549 ไดรั้บรางวลั  “ASEAN partner of the 
year” ดงัท่ีไดแ้สดงในรูปท่ี 1.2 

 

 

รูปที ่1. 2 A-HOST Proud Awards *1 

 

ปัจจุบนั A-HOST มีประเภทของสินคา้ และการบริการ ซ่ึงสามารถแบ่งออกเป็น 3 กลุ่มใหญ่ ๆ ไดแ้ก่ 

 

1.2.1 Hosting & Outsource Services 

เอ-โฮสต ์ ไดป้รับปรุงและขยายการใหบ้ริการ Hosting และ Outsource จนสามารถครอบคลุมความ
ตอ้งการของลูกคา้ไดห้ลากหลายโดยเรายดึหลกัในการให้บริการท่ีเรียกวา่ “Peace of Mind for the customer” 
ซ่ึงหมายถึงการท่ีจะท างานลูกคา้ไดอ้ยา่งครบวงจร เพื่อท่ีลูกคา้จะไดส้ามารถใชง้านระบบเทคโนโลยี
สารสนเทศท่ีมีประสิทธิภาพไดอ้ยา่งสบายใจไร้ความกงัวลต่อความเส่ียงต่าง ๆ ไม่วา่จะเป็นเร่ืองของปัญหา
ทางดา้นเทคนิค การจดัการระบบและขอ้มูลส ารองการปรับแต่งระบบใหไ้ดป้ระสิทธิภาพสูงสุด 
(Performance Tuning) และท่ีส าคญัท่ีสุดคือ การท่ีเขา้มารับภาระในดา้นการบริหารจดัการบุคลากรทางดา้น 
ไอทีทั้งหมดแทนลูกคา้  
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การใชบ้ริการ Hosting และ Outsource จะท า ใหลู้กคา้สามารถทุ่มเทเวลา และทรัพยากรขององคก์ร
ใหก้บัธุรกิจท่ีเป็นแกนหลกั (Core Business) โดยทัว่ไปแลว้บริการ Hosting และ Outsource ประกอบดว้ย
ส่วนประกอบและบริการยอ่ย ๆ ดงัต่อไปน้ี  

- High Availability and High Performance IT Infrastructure  

- Dedicated or Co-Location Service 

- Disaster Site 

- Oracle E-Business Applications (ERP, CRM, SCM)  

- ERP Implementation Service 

- System and Database Administration  

- Help Desk  

- On-Request Services i.e. On-site Support, Software Customization  

ทั้งน้ีการบริการ Hosting และ Outsource สามารถครอบคลุมไดท้ั้งระบบท่ีใชเ้ทคโนโลยีของ Oracle 
และ/หรือ ระบบท่ีใชเ้ทคโนโลยอ่ืีน ๆ   

 

1.2.2 Oracle Core Technology Product and Advanced Services   

เอ-โฮสตเ์ป็นผูน้ าในการด าเนินธุรกิจในฐานะ Value-Added Distributor ใหก้บั Oracle โดยไม่
เพียงแต่ท าหนา้ท่ีในการจดัจ าหน่ายสินคา้ในกลุ่ม Core Technology ของ Oracle ทุกประเภท แต่ยงัมีทีม
ผูเ้ช่ียวชาญท่ีจะใหก้ารสนบัสนุน และการบริการเสริมอยา่งครบวงจรแก่บริษทั คู่คา้และลูกคา้ ไม่วา่จะเป็น
การร่วมจดักิจกรรมทางการตลาด การฝึกอบรม การติดตั้งระบบและการใหค้  าปรึกษาเพื่อแกไ้ขปัญหาต่าง ๆ  

สินคา้บริการท่ีอยูใ่นกลุ่มของ Oracle Core Technology Products and Advanced Services ไดแ้ก่ 

- Oracle Database and database options  
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- Oracle Business Intelligence Suite  

- Business Partner Development  

- System Installation, Intelligence, and Optimization  

- Oracle Fusion Middleware (รวมถึง BEA) 

- สินคา้อ่ืน ๆ ทุกประเภทของ Oracle  

- Marketing and Lead Generation Activities 

- SOA-Based Development and Implementation   

 

1.2.3 Oracle Enterprise Performance Management (EPM) และ Hyperion Business Intelligence 

Products and Services 

ความตอ้งการสูงสุดประการหน่ึงของผูบ้ริหารในการน าเอาระบบไอทีมาใชใ้นองคก์ร ไม่วา่จะเป็น
ภาครัฐหรือเอกชน คือ การท าใหผู้บ้ริหารสามารถไดข้อ้มูลท่ีแสดงใหเ้ห็นถึงสถานะในการด าเนินธุรกิจได้
อยา่งแม่นย  า         รวดเร็ว และน าเอาขอ้มูลมาวิเคราะห์และวางแผนทั้งในระดบัปฏิบติัการ และในระดบักล
ยทุธ์ เพื่อใหธุ้รกิจสามารถไดเ้ปรียบ ปรับตวัตามสภาพเศรษฐกิจไดใ้นทุกสถานการณ์ Business Intelligence 
(BI) และเป็นระบบท่ีสนองตอบต่อความตอ้งการในลกัษณะดงักล่าวไดเ้ป็นอยา่งดี เอ-โฮสต ์ มีทีมงานท่ี
ปรึกษาท่ีมีประสบการณ์ทั้งทางดา้นธุรกิจและทางดา้นเทคนิค รวมถึงความเขา้ใจในระบบอยา่งลึกซ้ึง จึงท า
ใหส้ามารถใหบ้ริการท่ีปรึกษา    เพื่อออกแบบติดตั้ง เช่ือมโยง และปรับใชร้ะบบให้กบัลูกคา้ไดอ้ยา่งเป็น
ประโยชน์ และประสิทธิภาพสูงสุดอีกทั้ง ยงัมีความยดืหยุน่ และใหก้ารตอบสนองท่ีรวดเร็วอีกดว้ย 
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1.3 รูปแบบการจัดองค์กรและการบริหารองค์กรแบ่งตามประเภทการให้บริการที่รองรับ 
ทางสถานประกอบการณ์นั้นไดใ้หบ้ริการในดา้นต่าง ๆ มากมาย [2] ผูจ้ดัท าโครงงานจึงไดย้กตวัอยา่ง
บางส่วน ดงัท่ีไดแ้สดงในรูปท่ี 1.3 ซ่ึงผูจ้ดัท าโครงงานไดรั้บเลือกใหเ้ขา้ร่วมกบัแผนก Academy and BI ซ่ึง
สนบัสนุนการใหบ้ริการ BI Implementation Service 

 

รูปที ่1. 3 โครงสร้างขององคก์ร แบ่งตามรูปแบบบริการท่ีรองรับ 

 

 

1.4 ต าแหน่งและหน้าทีง่านทีนั่กศึกษาได้รับมอบหมาย 
 

ต าแหน่ง  Assistance Software Professional  

หนา้ท่ีงานท่ีไดรั้บมอบหมายทั้งหมดไดแ้สดงในตารางท่ี 1.1  

A-
HO

ST

Application Managed Service

Hosting Service

Supplementary Technical Service

ERP Implementation Services

BI Implementation Service

Software Development Service

System Upgrade and Migration Service

Disaster Recovery Solution

...
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ตารางที ่1. 1 ตารางแสดงหนา้ท่ีงานท่ีไดรั้บมอบหมาย 

 

หนา้ท่ีงานท่ีไดรั้บมอบหมาย ผลท่ีคาดวา่จะไดรั้บ 

1. ศึกษาคน้ควา้คุณสมบติัของ    
- BI Process 
- ETL 
- Cube 

- มีเอกสาร presentation  
- ความรู้และเขา้ใจ สามารถ present ได ้  

2. ศึกษาวิธีการติดตั้ง และการใชง้าน    
- Oracle Database 11g 
- Oracle Warehouse Builder 11g 
- IBM® Cognos Analytics 
- Oracle Business Intelligence Enterprise 

Edition 12c 
- IBM® InfoSphere® DataStage® 

- มีเอกสารวิธีการติดตั้ง และการใชง้านโดยละเอียด 
- สามารถสาธิตการติดตั้งและการใชง้านได ้
- มีการท า Demo ขอ้มูลท่ีสามารถใชง้านได ้

3. ท าหนา้ท่ีผูท้ดสอบระบบ ( Tester ) ใหก้บั
ระบบต่าง ๆ ท่ีเกิดข้ึนของแผนก 

- สามารถช่วยก าหนด Test case ได ้
- สามารถทดสอบระบบไดอ้ยา่งมีประสิทธิภาพ 

4. ช่วยSupport Project TAT BI 2015 - มีความรู้ความเขา้ใจเก่ียวกบัขอ้มูล การท่องเท่ียวเชิง
การตลาด 

- แกไ้ขปรับปรุงรายงานและขอ้มูล การท่องเท่ียวเชิง
การตลาด ตามท่ีไดรั้บมอบหมาย 

- ท าการเปิดเช็ครายงานของลูกคา้ ทุกรายงานและETL 
log เพ่ือเช็คสถานะการใชง้านเป็นประจ าทุกเชา้ 

- จดัท าเอกสาร Reconcile Report เพ่ือเช็คขอ้มูลของ
รายงานเป็นประจ าทุกเดือน 

5. ช่วยพ่ีเล้ียงใน class Training IBM® Cognos 
Analytic 

- ช่วยเป็น TA ในการสอน IBM® Cognos Analytic ได ้

6. มีการ Transfer งานทั้งหมด - สามารถ Transfer งานทั้งหมดใหส้หกิจรุ่นต่อไป 
- มีการท า Archive เกบ็เอกสารของงานไวท่ี้ Server 

7. จดัท า Individual Work List - น าเสนอ IWL เป็นประจ าทุกเดือน 
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1.5 พนักงานทีป่รึกษา และ ต าแหน่งของพนักงานทีป่รึกษา 
 ช่ือ นางสาวปาริชาติ ทองดอนนอ้ย และ นายระพีพฒัน์ ธนะพฒัน์ 

ต าแหน่ง Programmer 
 

1.6 ระยะเวลาทีป่ฏบิัติงาน 
ปฏิบติังานสหกิจศึกษาเป็นระยะเวลา  4   เดือนนบัตั้งแต่วนัท่ี 30 พ.ค. 2559 – 30 ก.ย. 2559 

 

1.7 ทีม่าและความส าคญัของปัญหา 
ในการท ารายงานต่าง ๆ ของทางแผนก Academy and BI นั้น จ าเป็นตอ้งน าขอ้มูลท่ีมีมาแปรรูปให้

เหมาะสมกบัการน าเสนอเพื่อท่ีจะไดต้อบสนองต่อความตอ้งการของผูใ้ชง้าน ซ่ึงหน่ึงในเคร่ืองมือท่ีมีความ
โดดเด่นในการแปรรูปขอ้มูลนั้นก็คือโปรแกรม DataStage® ซ่ึงเป็นหน่ึงในเคร่ืองมือของกลุ่ม InfoSphere® 
ท่ีสร้างข้ึนโดย IBM® ซ่ึงโปรแกรมน้ีมีจุดเด่นในเร่ืองของการประมวลผลแบบขนาน ซ่ึงส่งผลท าให้
กระบวนการแปรรูปขอ้มูลเป็นไปไดอ้ยา่งรวดเร็วมากข้ึน ทางแผนก Academy and BI ไดเ้ล็งเห็น
ประสิทธิภาพของโปรแกรม จึงไดท้  าการศึกษาการใชง้านและจดัท าคู่มือ เพื่อช่วยใหก้ารท าความเขา้ใจ
โปรแกรม เป็นไปไดอ้ยา่งรวดเร็วมากยิง่ข้ึน 

 

1.8 วตัถุประสงค์หรือจุดมุ่งหมายของโครงงาน 
1.  เพื่อเปิดโอกาสใหไ้ดล้งมือปฏิบติัโครงงานท่ีมีอยูจ่ริงในบริษทั ตั้งแต่เร่ิมตน้จนส้ินสุด 
2.  เพื่อจดัท าคู่มือการใชง้านโปรแกรม DataStage® ในระดบัพื้นฐาน ส าหรับลดระยะเวลาในการ

เรียนรู้ 
3.  เพื่อถ่ายทอดวธีิการใชง้าน Stage ต่าง ๆ ของ DataStage® ใหแ้ก่พนกังานท่านอ่ืน ๆ 
4.  เพื่อใหส้ามารถน าเสนอวธีิการใชง้านและผลลพัธ์ของ Stage ต่าง ๆ ของ DataStage® ได ้
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1.9 ผลทีค่าดว่าจะได้รับจากการปฏบิัติงานหรือโครงงานทีไ่ด้รับมอบหมาย 
1. สามารถอธิบายความแตกต่างและการท างานของกระบวนการ ETL และ ELT ได ้
2.  สามารถเลือกวธีิการแปรรูปขอ้มูลไดอ้ยา่งเหมาะสม 
3.  สามารถใชง้านและถ่ายทอดวธีิการใชง้านโปรแกรม IBM® InfoSphere® DataStage® ได ้

 

1.10  นิยามศัพท์เฉพาะ 
ค าศพัทต่์าง ๆ ท่ีใชใ้นรายงานฉบบัน้ีลว้นแต่เป็นค าท่ีสามารถพบไดท้ัว่ไป แต่ในกรณีของโครงงานน้ี จะใช้
ในบริบทของการจดัการขอ้มูลซ่ึงแสดงในตารางท่ี 1.2 

ตารางที ่1. 2 ตารางอธิบายนิยามศพัทเ์ฉพาะ 

ค าศพัท ์ ค าอธิบาย 

bridge ช้ินส่วนท่ีท าการแปลงนิยามขอ้มูลจากรูปแบบหน่ึงไปเป็นอีกรูปแบบ โดยการจบัคู่

องคป์ระกอบต่าง ๆ ของนิยามขอ้มูลเขา้กบัตน้แบบมาตรฐาน 

connector ช้ินส่วนท่ีจดัเตรียมการเช่ือมต่อขอ้มูล และการรวมนิยามขอ้มูล ส าหรับฐานขอ้มูล
ภายนอก ซ่ึงโดยทัว่ไปแลว้ ช้ินส่วนแต่ละช้ินจะถูกสร้างเพ่ือรองรับการเช่ือมต่อกบั
ฐานขอ้มูลเฉพาะ 

data source แหล่งของขอ้มูล ตวัอยา่งเช่นฐานขอ้มูล หรือไฟล ์XML รวมไปถึงสารสนเทศต่าง ๆ ท่ีใช้
เพื่อเขา้ถึงขอ้มูล 

job วตัถุท่ีออกแบบมาเพ่ือประมวลผลองคป์ระกอบต่าง ๆ ของโปรแกรม ไม่วา่จะเป็น การ
เช่ือมต่อกบัแหล่งขอ้มูล การสกดัขอ้มูล การแปรรูปขอ้มูล และการบรรจุขอ้มูลเขา้ท่ี
แหล่งขอ้มูลปลายทาง 

link คือสญัลกัษณ์ท่ีแทนทิศทางการไหลของขอ้มูล ระหวา่ง stage ต่าง ๆ ภายใน job 

reference link การเช่ือมต่อท่ีเขา้สู่ Transformer หรือ Lookup stage ท่ีก าหนดต าแหน่งของตารางท่ีใช้
ส าหรับการคน้หาขอ้มูลเพื่อน ามาขยายความ  

stage องคป์ระกอบของ job ท่ีท าหนา้ท่ีอธิบายแหล่งขอ้มูล ล าดบัการประมวลขอ้มูล หรือระบบ
ปลายทางท่ีไดนิ้ยามตรรกะของการประมวลผล ท่ีท าการเคล่ือนยา้ยขอ้มูลจาก link น าเขา้ 
ไปยงั link ส่งออก  
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บทที ่ 2  
ทฤษฎแีละเทคโนโลยทีีใ่ช้ในการปฏิบัตงิาน 

 
ในการปฏิบติังานสหกิจศึกษาคร้ังน้ี  เป็นการน าความรู้ทางดา้นทฤษฎีและเทคโนโลยมีาใชใ้น

การปฏิบติังานทุกส่วนตลอดการปฏิบติังานสหกิจศึกษา ซ่ึงเป็นการน าความรู้ทั้งท่ีเคยเรียนมาประยกุตใ์ช้
และเป็นการศึกษาเรียนรู้ส่ิงใหม่ ๆ ท่ีไดจ้ากการปฏิบติังาน ซ่ึงในหวัขอ้น้ีจะแบ่งออกเป็นสองส่วน ไดแ้ก่
ส่วนท่ีเก่ียวขอ้งกบัแนวคิดในการจดัการขอ้มูลในรูปแบบต่าง ๆ และแนวคิดของโปรแกรม และในส่วนท่ี
สองจะกล่าวถึงความสามารถต่าง ๆ ของโปรแกรม 
 

2.1 ทฤษฎทีีเ่กีย่วข้องกบัการแปรรูปข้อมูล 
 

2.1.1 ETL และ ELT [3] 

 

รูปท่ี 2.1 คือกระบวนการ ETL ซ่ึงก็คือการสกดั (Extract) แปรรูป (Transform) และจดัเก็บ (Load) ขอ้มูล ซ่ึง
ต่างจาก ELT ท่ีจะท าการสกดั (Extract) จดัเก็บ (Load) แลว้จึงแปรรูป (Transform) ขอ้มูล ซ่ึงแสดงในรูปท่ี 
2.2 ตรงท่ี กระบวนการจดัเก็บแบบ ETL นั้นจะถูกแยกเคร่ืองออกเป็นสองหรือสามส่วน โดยแบ่งเป็นเคร่ือง
ตน้ทาง (Source), เคร่ืองส าหรับแปรรูปขอ้มูล (Transformation Engine), และเคร่ืองปลายทาง (Target) หรือ
อาจจะรวมเคร่ืองตน้ทางกบัเคร่ืองท่ีใชแ้ปรรูปขอ้มูลเขา้ดว้ยกนั ซ่ึงมีขอ้ดีคือใชง้บประมาณในการติดตั้งนอ้ย

รูปที ่2. 1 แผนภาพลกัษณะการท างานแบบ ETL *3 



11 
 
กวา่แบบ ELT แต่มีโอกาสเกิดปัญหาไดเ้น่ืองจากการใชว้ิธีการส่งขอ้มูลแบบ Pipeline ซ่ึงจะตอ้งน าขอ้มูลมา
เก็บไวก่้อนท่ีช่วง Transform ในกรณีท่ีขอ้มูลมีปริมาณมากเกินไปและส่งต่อไดช้า้ ตวัอยา่งเช่นการสั่ง
จดัล าดบัของขอ้มูล ท่ีจะไม่สามารถส่งขอ้มูลต่อได ้ถา้ยงัอ่านขอ้มูลไม่ครบ จึงท าใหเ้กิดการ Burst ได ้

 

เพื่อแกไ้ขปัญหาการ Burst ของระบบ Pipeline จึงไดมี้การพฒันาวธีิการท า ELT (Extract, Load, Transform) 
ข้ึนมา โดยวธีิน้ีจะใชง้บประมาณในการติดตั้งระบบสูงกวา่ และมกัจะมีการวางโครงสร้างแบบแหล่งขอ้มูล
ตน้ทางและปลายทางอยูใ่นเคร่ืองเดียวกนั หรืออยูค่นละเคร่ือง แต่เคร่ืองท่ีจดัเก็บขอ้มูลปลายทางมีสมรรถนะ
การประมวลผลท่ีสูง ท าใหส้ามารถแปรรูปขอ้มูลไดอ้ยา่งสะดวก ซ่ึงวธีิน้ียงัมีขอ้ดีอีกอยา่งคือความสะดวกใน
การสืบคน้หาแหล่งท่ีมาของขอ้มูล 
 

2.1.2 Parallelism Basics 

การประมวลผลของ IBM® InfoSphere® Information Server [4] นั้นใชว้ธีิการ Pipeline Parallelism ร่วมกบั 
Partition Parallelism เพื่อท าใหส้ถาปัตยกรรมนั้นมีความยดืหยุน่ รองรับการขยายตวัของธุรกิจได ้ โดยยงั
รักษาประสิทธิภาพใหอ้ยูใ่นระดบัสูงเสมอ ซ่ึงเทคนิคต่าง ๆ ท่ีใชใ้นการล าเลียงขอ้มูลมีดงัน้ี 

- Data Pipelining คือ การเคล่ือนยา้ยขอ้มูลจากแหล่งขอ้มูลไปประมวลผลตามล าดบัขั้นท่ีไดก้ าหนด
ไวใ้น data-flow ซ่ึงการท าแบบน้ี จะท าใหส้ามารถแปรรูปขอ้มูลไดห้ลายคร้ังโดยท่ีไม่ตอ้งบนัทึก
ขอ้มูลระหวา่งขั้นตอน จุดเด่นของการใชเ้ทคนิคน้ี คือการใชค้วามสามารถในการประมวลผลอยา่ง

รูปที ่2. 2 แผนภาพลกัษณะการท างานแบบ ELT *3 
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เตม็ประสิทธิภาพ เน่ืองจากการล าเลียงท่ีต่อเน่ืองท าใหใ้ชส่้วนประมวลผลต่าง ๆ ซ่ึงแบ่งเป็น block 
ท างานพร้อมกนั จึงท าใหท้  างานไดอ้ยา่งรวดเร็วดงัรูปท่ี 2.3 

 

- Data Partitioning คือ การน าขอ้มูลท่ีจะท าการประมวลผล มาแบ่งเป็นชุดขอ้มูลยอ่ย ๆ แลว้จึงแบ่งให้
หน่วยประมวลผลแต่ละหน่วย ท างานแยกกนั โดยการแบ่งขอ้มูลนั้นจะตอ้งไม่มีผลกระทบต่อความ
ถูกตอ้งของขอ้มูลท่ีตอ้งการค านวณ โดยความเร็วของการค านวณจะเร็วข้ึนมากนอ้ยแค่ไหน ข้ึนกบั
รูปแบบของขอ้มูลท่ีท าการแบ่งและวธีิการท่ีใชแ้บ่งก็ข้ึนอยูก่บัรูปแบบขอ้มูลท่ีเหมาะสมต่อ Stage 
นั้น ๆ ซ่ึงโดยทัว่ไปแลว้ ขั้นตอนน้ีจะตอ้งสร้างดว้ยการใหผู้พ้ฒันา ออกแบบและสร้างวธีิการในการ
แบ่งชุดขอ้มูลเอง แต่ใน InfoSphere® นั้นไดส้ร้างมาให้แลว้  
ตวัอยา่งเช่น รูปท่ี 2.4 คือตวัอยา่งการแบ่งงานโดยใชต้วัอกัษรเร่ิมตน้ของนามสกุล 

 

รูปที ่2. 3 แผนภาพลกัษณะการท างานแบบ Data Pipelining *4 

รูปที ่2. 4 แผนภาพลกัษณะการท างานแบบ Data Partitioning *4 



13 
 

- Dynamic Repartitioning คือ วธีิการในการจดัการขอ้มูล ท่ีเกิดจากการผสมผสานระหวา่ง Data 
Pipelining และ Data Partitioning ซ่ึงจะไดรู้ปแบบตามรูปท่ี 2.5  

 
ซ่ึงวธีิการน้ี จะมีปัญหาในกรณีท่ีใชค้อลมัน์ของขอ้มูลในการจดัเก็บและการแบ่งช้ินส่วนต่างกนั จึงไดพ้ฒันา
ใหมี้รูปแบบดงัรูปท่ี 2.6  

 

ซ่ึงจะมีการท า Repartition หรือก็คือการจบัคู่ใหม่ระหวา่งขั้นตอนทุกขั้นตอน โดยเทคนิคน้ีก็รวมมากบั 
InfoSphere® Information Server เช่นกนั ท าใหผู้พ้ฒันาไม่จ  าเป็นท่ีตอ้งพฒันาขั้นตอนน้ีดว้ยตนเอง 

  

รูปที ่2. 5 แผนภาพลกัษณะการท างานแบบ Data Repartitioning *4 

รูปที ่2. 6 แผนภาพลกัษณะการท างานแบบ Data Repartitioning *4 
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2.1.3 Information Server Backbone 

 

รูปท่ี 2.7 แสดงใหเ้ห็นโครงสร้างของ Information Server ท่ีมี Application ต่าง ๆ [5] อยูใ่นแถวบนสุด ซ่ึง 
Application ทั้งหมดน้ีจะใช ้Service ในแถวกลางร่วมกนั โดยท่ีทุก Application ใช ้Repository ท่ีแสดงอยูต่รง
มุมขวาล่างร่วมกนั โดยการจดัการ Application ต่าง ๆ สามารถท าไดด้ว้ยการใช ้ Information Server Web 
Console หรือใช ้Client ของ Application นั้น ๆ ซ่ึงแต่ละ Application จะมีลกัษณะเด่นดงัน้ี 

- Information Services Director ท าหนา้ท่ีในการรวบรวมขอ้มูลและน าเสนอสารสนเทศในรูปแบบของ real-
time service พร้อมทั้งสามารถน าหลกัตรรกะท่ีเขียนไว ้กลบัมาใชซ้ ้ าได ้

- Business Glossary ช่วยในการก าหนดค าศพัทท์างธุรกิจขององคก์ร และช่วยในการสร้างและจดัการวธีิการ
แบ่งหมวดหมู่ต่าง ๆ เพื่อช่วยในการจดัระเบียบใหข้อ้มูล 

- Information Analyzer ช่วยในการตรวจสอบและประเมินคุณภาพของขอ้มูล ออกแบบกฎต่าง ๆ  ท่ีใชค้วบคุม
ขอ้มูล และวเิคราะห์ขอ้มูล เพื่อช่วยในการตีความขอ้มูล 

- DataStage® ช่วยในการรวบรวมขอ้มูลท่ีมาจากแหล่งขอ้มูลหลายๆแหล่ง ซ่ึงอาจจะติดตั้งอยูบ่นระบบท่ี
แตกต่างกนั ซ่ึงรวมไปถึง big data โดยใชว้ธีิการท างานแบบขนาน เพื่อประสิทธิภาพสูงสุด 

รูปที ่2. 7 แผนผงัโครงสร้างของ InfoSphere® *5 
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- QualityStage ช่วยในการสร้างและรักษาความสอดคลอ้งของขอ้มูล เพื่อช่วยใหข้อ้มูลอยูใ่นรูปแบบท่ี
ถูกตอ้งเสมอ 

- Metadata Workbench สามารถเขา้ใชผ้า่นทาง browser โดยช่วยแสดงผลของ metadata ท่ีสร้างโดย 
Information Server ในรูปแบบของรูปภาพ เพื่อใหผู้ใ้ช ้สามารถใชง้านไดง่้ายข้ึน 

*ถึงแมว้า่ DataStage® และ QualityStage จะใชลิ้ขสิทธ์ิคนละชุดและนบัเป็นสินคา้คนละช้ิน แต่ปกติแลว้ 
QualityStage จะถูกฝังอยูใ่น DataStage® ในรูปแบบของ Stage ต่าง ๆ 

 

2.2 เทคโนโลยทีีใ่ช้ในการปฏบิัติงาน 
2.2.1 IBM® InfoSphere® DataStage® 
 

2.2.1.1 DataStage® Introduction 

IBM® InfoSphere® DataStage® เป็นเคร่ืองมือท่ีใชร้วบรวมขอ้มูลของ IBM® InfoSphere® 
Information Server โดยการออกแบบ พฒันา และใชง้าน job ต่าง ๆ ท่ีท าหนา้ท่ีโอนถ่ายและแปรรูปขอ้มูล ซ่ึง 
data flow และ framework ของ job ต่าง ๆ จะมีการแสดงผลในรูปแบบของรูปภาพ graphic ท าใหเ้ขา้ใจไดง่้าย
และเป็นมิตรต่อผูใ้ชง้าน นอกจากน้ี DataStage® ยงัรองรับการดึงขอ้มูลจากแหล่งต่าง ๆ ท่ีมีระบบต่างกนั 
และสามารถส่งต่อขอ้มูลท่ีปรับแต่งอยา่งเหมาะสมแลว้ไปยงั data warehouse, data mart, operational data 
store, real-time web service และ messaging system หรือแอปพลิเคชนัอ่ืน ๆ ขององคก์รไดโ้ดยตรงเพื่อความ
สมบูรณ์และความถูกตอ้งของขอ้มูล นอกจากน้ี DataStage® ยงัมี prebuilt functions ต่าง ๆ เพื่อช่วยลด
ระยะเวลาพฒันาระบบและช่วยตรวจสอบความสอดคลอ้งของขอ้มูล พร้อมทั้งรองรับกระบวนการท างานทั้ง
แบบ ETL และ ELT นอกจากน้ี DataStage® ยงัถูกพฒันาข้ึนเพื่อรองรับการขยายตวัขององคก์รโดยใชเ้ทคนิค
การประมวลผลแบบขนาน 
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2.2.1.2 DataStage®’s Roles 

ใน DataStage® จะมีการก าหนดบทบาท (Role) ต่าง ๆให้กบัผูใ้ช ้[6] เพื่อเป็นการก าหนด ควบคุม และจ ากดั
สิทธิต่าง ๆ ของผูใ้ช ้บทบาทของผูใ้ชส้ามารถจ าแนกออกเป็น 4 บทบาทดงัน้ี 

1. Administrator หรือ ผูดู้แลระบบ เป็นบทบาทสูงสุด มีสิทธิในการก าหนดการตั้งค่าต่าง ๆ ได้
ทั้งหมด สามารถเพิ่ม ลบ และประกาศใชง้าน Project ได ้สามารถบริการจดัการสิทธิต่าง ๆ ของ
ผูใ้ชไ้ด ้โดยผูดู้แลระบบจะท างานผา่นทาง Command Interface ของ DataStage® Repository 

2. Manager หรือ ผูจ้ดัการระบบ มีสิทธิในการเขา้ชมและแกไ้ข Project ต่าง ๆ รวมถึงการจดัเก็บ
และบริหารจดัการ Metadata ท่ีสามารถน ามาใชใ้หม่ได ้ โดยท่ีผูจ้ดัการระบบจะท างานผา่นทาง 
Main Interface ของ DataStage® Repository 

3. Designer/Developer หรือ ผูอ้อกแบบ/ผูพ้ฒันาระบบ มีสิทธิในการสร้าง Job ต่าง ๆ โดย
ผูอ้อกแบบ/ผูพ้ฒันาระบบจะมี User Interface แบบ Visual ส าหรับการแสดงผล Data Flow 

4. Director หรือ ผูดู้แล มีสิทธิในการทดสอบ ติดตาม ก าหนด และจดัการการท างานของ Job ต่าง 
ๆ 

 

2.2.1.3 DataStage®’s Job 

Job คือ การจดักลุ่มของ Stage ซ่ึงอาจจะมีหลาย Stage หรือมีเพียง Stage เดียวก็ได ้ในกรณีท่ีมีหลาย Stage ก็
จะมีการเช่ือมต่อดว้ย Link โดยท่ี Stage นั้นเป็นตวัแทนของแหล่งขอ้มูล (Data Source) กระบวนการแปลง
ขอ้มูล (Transformation) และเป้าหมายท่ีจะท าการเก็บขอ้มูล (Target) เม่ือน า Job มาเรียงต่อกนัเพื่อก าหนด
ล าดบัการท างาน จะถูกเรียกวา่ Job Flow 
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2.2.1.4 Job Lifecycle 

DataStage® ช่วยอ านวยความสะดวกในการจดัการขอ้มูล โดยใช ้Job ต่าง ๆ ซ่ึงการพฒันาระบบข้ึนมานั้นจะ
มีทั้งหมด 4 ขั้นตอน ไดแ้ก่ Develop, Test, Deploy, Operate 

1. Develop (พฒันา) [7] คือขั้นตอนการจดัการ Job Flow ให้โอนถ่ายขอ้มูลจากตน้ทาง (Source) สู่ปลายทาง 
(Target) อยา่งถูกตอ้งเหมาะสม โดยใช ้ Designer client ในการจดัการ นอกจากน้ี ในกระบวนการน้ี
สามารถตรวจสอบขอ้ผิดพลาดโดยการ compile Job Flow ท่ีเขียนข้ึนมา โดยในขั้นตอนการพฒันานั้น 
สามารถแบ่งแยกยอ่ยไดอี้ก 3 ขั้นตอน ดงัรูปท่ี 2.8 

 

รูปที ่2. 8 แผนผงัขั้นตอนการพฒันา Job *7 
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1.1. Define the Job Flow หรือก็คือการออกแบบ Job Flow สามารถท าไดโ้ดยจดัเรียง Stage ต่าง ๆ บน 
Designer Canvas และเช่ือมต่อ Stage ต่าง ๆ ดว้ย Link ซ่ึง Link จะท าหนา้ท่ีส่งต่อ Metadata โดย 
stage เป็นตวัแทนของแหล่งขอ้มูล (Data Source) กระบวนการแปลงขอ้มูล (Transformation) และ
เป้าหมายท่ีจะท าการเก็บขอ้มูล (Target) ในขั้นตอนน้ี สามารถแบ่งแยกยอ่ยไดอี้ก 4 กระบวนการ
ดงัน้ี 

1.1.1. Add source stages คือการก าหนดแหล่งขอ้มูล (Data Source) 
1.1.2. Add transformation stages คือการก าหนดกระบวนการแปลงขอ้มูล (Transformation) 
1.1.3. Connect the stages คือการก าหนด Link ซ่ึง Link จะท าหนา้ท่ีส่งต่อ Metadata 
1.1.4. Add target stages คือการก าหนดเป้าหมายท่ีจะท าการเก็บขอ้มูล (Target) 

1.2. Configure the Job หรือก็คือการตั้งค่า Job ซ่ึงสามารถท าไดโ้ดยการตั้งค่า Stage ต่าง ๆ เพื่อเจาะจง
กระบวนการแปรรูปขอ้มูล หรือเพิ่ม Job Parameter เพื่อใหรั้บค่าในเวลาท่ีเรียกใชร้ายงานเพื่อเล่ียง
การก าหนดค่าล่วงหนา้ หรือเพิ่ม Table Definition ท่ีเก็บขอ้มูลเก่ียวกบัโครงสร้างขอ้มูลซ่ึงสามารถ 
Import จาก Database อ่ืน ๆ ได ้ไม่วา่จะเป็นทาง Source หรือ Target 

1.3. Review Compilation Errors เป็นการตรวจสอบ Stage ต่าง ๆ วา่มีขอ้ผดิพลาดหรือไม่ ซ่ึงสามารถตั้ง
ค่าให ้Highlight Stage แรกท่ีมีปัญหาได ้นอกจากน้ีระบบยงัช่วยระบุปัญหาเพื่อช่วยในการคน้หาจุด
ท่ีผดิพลาดและจุดท่ีตอ้งท าการแกไ้ข  

 

ในรูปท่ี 2.9 พบปัญหาคือการตั้งค่าของ Transformer Stage ช่ือ Trim_Prep ไม่ครบถว้น ดงันั้นระบบ
จึงท าการ Highlight Stage ช่ือ Trim_Prep 

รูปที ่2. 9 ตวัอยา่งการแสดง Stage ท่ีเกิดความผิดพลาดข้ึน *7 
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2. Test (ทดสอบ) [8] คือขั้นตอนทดสอบเพื่อ Debug Job ท่ีเขียนข้ึน โดยใชเ้คร่ืองมือ Interactive Debugging 

ในการตรวจสอบ ขั้นตอนน้ีต่างจาก Review Compilation Errors ในขั้นตอนท่ีแลว้ตรงท่ี ขั้นตอนน้ีจะ
เนน้การตรวจสอบขอ้มูลเป็นหลกั ซ่ึงขอ้มูลนั้นสามารถใชไ้ดท้ั้งแบบ Sample หรือจะ Generate ขอ้มูล
ข้ึนมาเพื่อทดสอบก็ได ้ ในขณะท่ี Review Compilation Errors ในขั้นตอนท่ีแลว้จะเป็นการคน้หาและ
ตรวจสอบ Error ท่ีเกิดข้ึนระหวา่ง Compile 

 
ขั้นตอนน้ีสามารถแบ่งแยกยอ่ยได ้2 ส่วน ดงัรูปท่ี 2.10 
2.1. Use debugging stages คือขั้นตอนการก าหนดขอ้มูลเพื่อท่ีจะทดสอบการท างานของ Job วา่ท างาน

ถูกตอ้งตามท่ีออกแบบเอาไวห้รือไม่ ซ่ึงขอ้มูลส าหรับทดสอบจะสามารถหามาไดด้ว้ย 2 วธีิ 
2.1.1. Generate test data เป็นวธีิการ Generate ขอ้มูลท่ีจะใชท้ดสอบข้ึนมา ซ่ึงสามารถใชข้อ้มูลจาก

ฐานขอ้มูลอ่ืนมาประกอบ เพื่อช่วยเพิ่มรายละเอียดของขอ้มูลใหม้ากข้ึน 

รูปที ่2. 10 แผนผงัขั้นตอนการทดสอบ Job *8 
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2.1.2. Sample the data เป็นวธีิการท าส าเนาส่วนหน่ึงของขอ้มูล เพื่อน ามาทดสอบ โดยใช ้Stage ท่ีมี
ช่ือวา่ Peek Stage ซ่ึงมีการใชง้านเหมือนในรูปท่ี 2.11 

 

2.2. Run in debug mode ในโหมดน้ีจะสามารถส ารวจขอ้มูลภายในคอลมัน์หรือค่าของตวัแปรต่าง ๆ ได้
โดยการใช ้ Breakpoint ซ่ึงก็คือการก าหนดต าแหน่งท่ีจะหยดุการท างานชัว่คราว เพื่อตรวจสอบ
ขอ้มูลระหวา่งการประมวลผลหรือแปรรูปขอ้มูลได ้นอกจากน้ี Breakpoint ยงัสามารถก าหนดแบบ
เป็นเง่ือนไขได ้เช่นก าหนดใหห้ยดุการท างานทุก ๆ 5 แถว 
 

3. Deploy (ติดตั้ง) [9] ขั้นตอนน้ีไม่ไดเ้ก่ียวขอ้งกบั DataStage® โดยตรง แต่เป็นการใชเ้คร่ืองมือช่ือ 
Information Server Manager ในการคน้หาวตัถุต่าง ๆ  ท่ีจ  าเป็นต่อการท างานของ Job หรือก าหนดวตัถุอ่ืน 
ๆ ท่ีตอ้งการท่ีจะติดตั้งลงบนระบบ โดยจะแบ่งแยกยอ่ยไดอี้ก 4 ขั้นตอนเหมือนรูปท่ี 2.12 ดงัน้ี  

รูปที ่2. 11 ตวัอยา่งการใชง้าน Peek Stage *8 

รูปที ่2. 12 แผนผงัขั้นตอนการติดตั้ง Job *9 
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3.1. Define the Package คือขั้นตอนนิยาม Package หรือก็คือการใหค้วามหมายหรือก าหนดลกัษณะของ 
Package วา่จะประกอบไปดว้ยอะไรบา้ง ซ่ึงการนิยามน้ีจะท าเพียงหน่ึงคร้ัง เม่ือมีความเปล่ียนแปลง
เกิดข้ึน Package สามารถท่ีจะ Rebuild, Recopy และ Redeploy ได ้

3.2. Build the Package คือขั้นตอนสร้าง Package หลงัจากท่ีไดนิ้ยามไวแ้ลว้ ก็จะท าการส าเนาขอ้มูลมา
จากตน้ทาง โดยขอ้มูลท่ีท าส าเนามาเก็บจะเป็นไปตามขอ้มูลท่ีเราไดก้ าหนดหรือไดนิ้ยามเอาไว ้
โดยขั้นตอนน้ีสามารถท่ีจะเขียนทบัขอ้มูล Package เก่าทั้งหมด หรือจะอพัเดทขอ้มูลใน Package 
โดยอา้งอิงจากการแกไ้ขคร้ังล่าสุด หลงัจากท่ีท าการสร้าง Package แลว้ Package จะมีสถานะท่ี
พร้อมส าหรับการน าไปติดตั้ง 

3.3. Deploy the Package เป็นการน า Package ท่ีไดส้ร้างไวไ้ปติดตั้งเขา้กบัระบบ โดยจะแบ่งแยกยอ่ยได้
อีก 2 ขั้นตอน 

3.3.1. Deploy on the test system คือการน า Packageไปติดตั้งบนระบบท่ีสร้างไวเ้พื่อทดลองการ
ท างาน 

3.3.2. Deploy on the production system คือการน า Package ไปติดตั้งบนระบบจริง 
 

4. Operate (ด าเนินการ) [10] เป็นขั้นตอนท่ีใชเ้คร่ืองมือ DataStage® และ QualityStage ในการจดัการ
ทรัพยากรของระบบและเรียกใช ้Job ท่ีไดท้  าการติดตั้งลงบนระบบแลว้  

 
รูปท่ี 2.13 ไดแ้สดงแผนวงจรชีวติของ Job ในขั้น Operate ซ่ึงในขั้นตอนน้ีจะมี Dashboard ช่วยแสดง 
workload ของ Job ท่ีท  างานอยู,่ Job ท่ีท างานเสร็จแลว้, การใชท้รัพยากรของระบบ นอกจากน้ียงัติดตาม
จ านวน Job ท่ีท างานส าเร็จและ Job ท่ีท างานลม้เหลวรวมถึงสถานะของ Key Service ซ่ึง Job เหล่าน้ี
สามารถท่ีจะก าหนดล าดบัความส าคญัและสามารถท่ีจะ Drill Down เพื่อดูรายละเอียดได ้ และ มีระบบ
แจง้เตือนตามเกณฑท่ี์ก าหนดผา่นทาง Dashboard 
 

รูปที ่2. 13 แผนผงัวงจรชีวติของ Job *10 
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2.2.1.6 Job Design 

คือ ขั้นตอนการออกแบบ Job ใหส้กดัขอ้มูลมาจากหลายแหล่งขอ้มูล แปรรูปใหเ้ป็นขอ้มูลท่ีตอ้งการแลว้จึง
จดัเก็บลงในระบบท่ีตอ้งการ ซ่ึง Job นั้นประกอบดว้ย Stage และ Link ดงันั้นการออกแบบ Job จึงจ าเป็นท่ี
จะตอ้งรู้จกั Stage ต่าง ๆ ซ่ึงมีตวัอยา่งการใชง้านท่ีแบ่งหมวดหมู่ตามล าดบัดงัน้ี 

1. Extract and load data 
2. Transform data 
3. Enrich data 
4. Cleanse data 
5. Real-time processing 
6. Big data processing 
7. Combine jobs in a sequence job 

 
1. Extract and Load Data [11] 

ในหมวดน้ีจะเก่ียวขอ้งกบัการยา้ยขอ้มูลต่าง ๆ  ไม่วา่จะเป็นการสกดัขอ้มูลจากแหล่งขอ้มูล (Source) หรือ
การจดัเก็บขอ้มูลเขา้คลงัขอ้มูล นอกจากน้ียงัรวมถึงการตรวจสอบความเปล่ียนแปลงภายในฐานขอ้มูล
อีกดว้ย 
1.1. Extract Data from a Database to a File or Data Set 

คือ การสกดัขอ้มูลออกมาจากฐานขอ้มูลแลว้น าไปเก็บในรูปแบบของ File หรือ Data Set 
1.2. Load Data with High-speed Native Connectivity 

คือ การน าขอ้มูลท่ีอ่านจากแหล่งขอ้มูลมาจดัเรียงและจดัเก็บลงฐานขอ้มูลในรูปแบบ Native 
Format เพื่อเพิ่มความเร็วในการท างาน เช่น การน าขอ้มูลจากภายนอกบริษทัมาใส่ไวใ้น Netezza 
Table โดยใช ้Stage ท่ีมีช่ือวา่ Netezza Connector โดยท่ีในตวัอยา่งไดใ้ช ้Native API เพื่อช่วยให้
ท างานไดเ้ตม็ประสิทธิภาพดงัท่ีไดแ้สดงตวัอยา่งในรูปท่ี 2.14 

รูปที ่2. 14 ตวัอยา่งการใช ้Netezza Connector *11 
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1.3. Load Data in Real Time to a Data Warehouse 
คือ การรับขอ้มูลท่ีอยูร่ะหวา่งกระบวนการ Transaction มาแปรรูปแลว้จดัเก็บลงในคลงัขอ้มูล 

1.4. Extract Data from SAP 
คือ การสกดัขอ้มูลออกมาจาก SAP ซ่ึงสามารถใช ้ Stage ท่ีมีช่ือวา่ ABAP Extract ซ่ึงขอ้มูลท่ีได ้
สามารถน าไปแปรรูปดว้ย Transformer Stage ก่อนท่ีจดัเก็บได ้ ซ่ึงรูปแบบท่ีจดัเก็บไดก้็มี
หลากหลายรูปแบบ เช่น SAP Business Warehouse, ฐานขอ้มูลขององคก์ร, ไฟล ์ฯลฯ 

1.5. Fetch Data from a Web Service to Enrich Data 
คือ การน าขอ้มูลจาก Web Service มาขยายความขอ้มูลท่ีมีอยู ่ตวัอยา่งเช่นในรูปท่ี 2.15 ท่ีน า Web 
Services Transformer Stage มาใชใ้นการสกดัและแปรรูปขอ้มูล Employee จาก Sequential_File_1 
แลว้จึงส่งขอ้มูลต่อให ้XML Stage ซ่ึงจะท าการ Generate Row และ Column แลว้จึงน าไปเก็บใน 
Sequential_File_2   

 
1.6. Identify Database Changes 

คือ การตรวจสอบความเปล่ียนแปลงของฐานขอ้มูล โดยใช ้ InfoSphere® Change Data Capture 
(CDC) ซ่ึงเป็นส่วนหน่ึงของ IBM® InfoSphere® Data Replication ซ่ึงจะท าหนา้ท่ีในการจบัความ
เปล่ียนแปลงท่ีเกิดข้ึนแลว้จึงส่งให ้DataStage®, ฐานขอ้มูลปลายทาง หรือคิวขอ้ความ โดยหลกัการ
ท างานคือ เก็บ Log ของการเปล่ียนแปลงต่าง ๆ เอาไว ้ท าใหล้ดภาระการท างานของ ETL Server 
เน่ืองจากไม่ตอ้งหาความเปล่ียนแปลงท่ีเกิดข้ึน และแกไ้ขเฉพาะขอ้มูลท่ีมีการเปล่ียนแปลงเท่านั้น 

  

รูปที ่2. 15 ตวัอยา่งการน าขอ้มูลจาก Web Service มาช่วยท าใหข้อ้มูลมีความสมบูรณ์มากข้ึน *11 
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2. Transform Data [12] 

ในหมวดน้ี จะเก่ียวขอ้งกบัตวัอยา่งการแปรรูปขอ้มูลในรูปแบบต่าง ๆ ดงัน้ี 
2.1. Transform Data with Expressions 

คือ การแปรรูปขอ้มูลดว้ย Expression โดยใช ้Transformer Stage เช่นการตดัช่องวา่งหวัทา้ย การน า
ขอ้ความมาต่อกนั การน าขอ้มูลไปค านวณ เป็นตน้ 

2.2. Join Data from Multiple Flat Files 
คือ การอ่านขอ้มูลจากหลายๆไฟลแ์ลว้น ามาเขียนเป็นไฟลเ์ดียวโดยการใช ้Join Stage ดงัท่ีแสดงใน
รูปท่ี 2.16 

 
2.3. Join Heterogeneous Sources 

คือ การอ่านขอ้มูลจากหลายๆระบบ น ามารวมกนั และจดัใหมี้รูปแบบเดียวกนั เพื่อสร้างฐานขอ้มูล
ท่ีถูกตอ้ง แม่นย  า และเช่ือถือไดเ้พียงหน่ึงฐานขอ้มูล ตวัอยา่งเช่น ในตวัอยา่งมีการน าขอ้มูลมาจาก
ฐานขอ้มูล Oracle และ Teradata ซ่ึงไดท้  าการแปรรูปขอ้มูลท่ีไดจ้ากฐานขอ้มูล Oracle ก่อนหน่ึง
คร้ัง แลว้จึงน ามา Join กบัขอ้มูลจากฐานขอ้มูล Teradata แลว้จึงน าขอ้มูลทั้งหมดไปแปรรูปอีกคร้ัง 
ก่อนจะท าการจดัเก็บโดยใช ้Netezza Connector Stage ดงัรูปท่ี 2.17 
 
 

  

รูปที ่2. 16 ตวัอยา่งการใชง้าน Join Stage *12 
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2.4. Summarize Data by Common Characteristic 

คือ การสรุปขอ้มูลโดยใช ้ Aggregator Stage ซ่ึงสามารถจดักลุ่มขอ้มูลท่ีตอ้งการสรุปยอดได้
มากกวา่ 1 กลุ่ม ตวัอยา่งเช่น จดักลุ่มดว้ยวนั (วนัจนัทร์ ถึง วนัอาทิตย)์ และจดักลุ่มดว้ยเดือน เพื่อหา
ผลสรุป ซ่ึงอาจจะแสดงให้เห็นไดว้า่ วนัไหนของสัปดาห์เป็นวนัท่ียุง่ท่ีสุด ซ่ึงอาจจะแตกต่างกนัไป
ตามฤดูกาล ดงัรูปท่ี 2.18 

 
2.5. Pivot Data in a Table 

คือ การ Pivot Table โดยการใช ้Pivot Enterprise Stage ซ่ึงสามารถแบ่งออกมาเป็น Horizontal Pivot 
ซ่ึงก็คือการน าขอ้มูลประเภทเดียวกนัในหลายๆคอลมัน์ในแถวเดียวกนั มากระจายออกเพื่อลด
ปริมาณคอลมัน์ลง โดยจ านวนแถวท่ีเพิ่มข้ึนจะสัมพนัธ์กบัจ านวนคอลมัน์ท่ีลดลงไป กบั Vertical 
Pivot ซ่ึงก็คือการน าขอ้มูลท่ีเหมือนกนัในหลายๆแถวมารวมกนัเป็น 1 แถว และเพิ่มคอลมัน์ให้
สอดคลอ้งกบัขอ้มูลท่ีเปล่ียนแปลง ดงัรูปท่ี 2.19 

รูปที ่2. 17 ตวัอยา่งการใชง้าน Join Stage ในการ Join ขอ้มูลจากฐานขอ้มูล Oracle และ Teradata *12 

รูปที ่2. 18 ตวัอยา่งการใชง้าน Aggregator Stage *12 
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2.6. Find Deltas from Yesterday’s File 

คือ การหาความเปล่ียนแปลงท่ีเกิดข้ึนระหวา่งไฟล ์ เช่นไฟลข์องเม่ือวานกบัไฟลว์นัน้ี ซ่ึงความ
เปล่ียนแปลงท่ีเกิดข้ึนนั้น จะสามารถเปรียบเทียบไดโ้ดยการใช ้Change Capture Stage และจะได้
ผลลพัธ์เป็นขอ้มูลของความเปล่ียนแปลง ซ่ึงในตวัอยา่งคือการเปรียบเทียบไฟลข์องเม่ือวานและ
วนัน้ี โดยใช ้Change Capture Stage ในการหาความเปล่ียนแปลง แลว้จึงส่งขอ้มูลความเปล่ียนแปลง
ไปเก็บไวใ้นฐานขอ้มูล Teradata โดยใช ้Teradata Connector Stage ดงัรูปท่ี 2.20 

 
3. Enrich Data [13] 

ในหมวดน้ีจะเก่ียวขอ้งกบัการเพิ่มรายละเอียดของขอ้มูล เพื่อท าใหข้อ้มูลมีความสมบูรณ์มากข้ึน โดย
การน าขอ้มูลจากแหล่งอ่ืนมาใชข้ยายความ ซ่ึงขั้นตอนน้ียงัรวมถึงการก าหนดกฎทางธุรกิจต่าง ๆ เพื่อ
ควบคุมการท างานต่าง ๆ 
 

รูปที ่2. 19 ตวัอยา่งการใชง้าน Pivot Enterprise Stage *12 

รูปที ่2. 20 ตวัอยา่งการใชง้าน Change Capture Stage *12 
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3.1. Look Up Reference Data for Data Enrichment 
คือ การเพิ่มรายละเอียดขอ้มูลโดยน ามาจากแหล่งท่ีสามารถอา้งอิงถึงได ้ โดยใช ้ Lookup Stage 
ตวัอยา่งเช่นในตวัอยา่งท่ีน าขอ้มูลลูกคา้มาจากฐานขอ้มูล DB2 แลว้ Lookup เพื่อน าขอ้มูลรหสั
ประเทศจากฐานขอ้มูล Oracle มาขยายความ แลว้จึงจดัเก็บในรูปแบบ Sequential File ดงัรูปท่ี 2.21 

 

3.2. Apply Business Rules 
คือ การน ากฎท่ีเคยสร้างไวม้าใชก้บัขอ้มูลชุดอ่ืน ๆ เพื่อท าใหข้อ้มูลเป็นไปในทางเดียวกนั โดยใช ้
ILOG JRules Connector Stage ซ่ึงสามารถเขา้ถึงเซ็ตของกฎต่าง ๆ ท่ีอยูภ่ายใน Operational 
Decision Manager ได ้ดงัเช่นรูปท่ี 2.22 

  

รูปที ่2. 21 ตวัอยา่งการใชง้าน Lookup Stage *13 

รูปที ่2. 22 ตวัอยา่งการใชง้าน ILOG JRules Connector Stage *13 
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4. Cleanse Data [14] 

ในหมวดน้ีจะเก่ียวขอ้งกบัการจดัรูปแบบและตรวจสอบขอ้มูล เพื่อใหข้อ้มูลถูกเก็บในรูปแบบท่ีตอ้งการ 
4.1. Standardize Data 

คือ การจดัรูปแบบของขอ้มูล เพื่อท าใหข้อ้มูลแต่ละ Record มีมาตรฐานเดียวกนัเพื่อช่วยในการ
คน้หาขอ้มูล โดยใช ้ Standardize Stage ซ่ึงมากบั IBM® InfoSphere® QualityStage ซ่ึงสามารถ
แกไ้ขกฎต่าง ๆ ไดโ้ดยการใช ้IBM® InfoSphere® QualityStage Standardization Rules Designer 
ซ่ึงมีลกัษณะเป็น web-base และเป็นเคร่ืองมือแบบ data-driven classification ดงัรูปท่ี 2.23 

 

4.2. Verify International Addresses 
คือ การตรวจสอบและจดัรูปแบบของขอ้มูลเก่ียวกบัท่ีอยู ่ วา่เป็นสถานท่ี ท่ีสามารถจดัส่งไปได้
หรือไม่ โดยใช ้Address Verification Stage ซ่ึงมีมากบั IBM® InfoSphere® QualityStage Address 
Verification Interface ดงัรูปท่ี 2.24 

  

รูปที ่2. 23 ตวัอยา่งการใชง้าน Standardize Stage *14 

รูปที ่2. 24 ตวัอยา่งการใชง้าน Address Verification Stage *14 
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4.3. Match Records to Identify Duplicates 
คือ การหาขอ้มูลท่ีซ ้ ากนั โดยใชว้ธีิการจบัคู่ขอ้มูลท่ีมีการช้ีไปยงัเป้าหมายเดียวกนั โดยในตวัอยา่ง
ไดมี้การใช ้Match Frequency Stage ดงัรูปท่ี 2.25 

 
4.4. Validate Data with Data Rules 

คือ การตรวจสอบคุณภาพของขอ้มูลวา่เป็นไปตามท่ีตอ้งการหรือไม่ โดยใช ้Data Rules Stage ซ่ึง
สามารถก าหนดกฎเกณฑไ์ดด้ว้ย IBM® InfoSphere® Information Analyzer ดงัรูปท่ี 2.26 

 

รูปที ่2. 25 ตวัอยา่งการใชง้าน One Source Match Stage *14 

รูปที ่2. 26 ตวัอยา่งการใชง้าน Data Rules Stage *14 
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5. Real-time Processing [15] 

ในหมวดน้ีจะเก่ียวขอ้งกบัการรวบรวมขอ้มูลแบบ real-time ผา่นทาง web service 
5.1. Respond to a Web Service Request 

คือ การก าหนดการน าขอ้มูลเขา้ Job จาก web service ดว้ย ISD Input Stage และส่งกลบัไปยงั web 
service ดว้ย ISD Output Stage โดยการใช ้InfoSphere® Information Services Director นอกจากน้ี 
ยงัสามารถน า Job น้ีไปใชง้านแบบ Service ไดด้งัตวัอยา่งในรูปท่ี 2.27 

 
5.2. Verify Data between Message Queues 

คือ การสร้าง Job ท่ีสามารถรับขอ้มูลจาก Messaging Queue และจดัเก็บขอ้มูลเขา้ Messaging Queue 
ซ่ึงตวัอยา่งในรูปท่ี 2.28 จะใช ้ IBM® WebSphere MQ Connector Stage ส าหรับการรับขอ้มูล 
จากนั้นจึงน ามาจดัรูปแบบดว้ย Standardize Stage, น าไปคดัแยกดว้ย Data Rules Stage แลว้จึงน าไป
เก็บขอ้มูลเขา้ Messaging Queue โดยใช ้IBM® WebSphere MQ Connector Stage ในกรณีท่ีขอ้มูล
ไดรั้บการ Verified จาก Data Rules Stage และจดัเก็บในฐานขอ้มูล DB2 ในกรณีท่ีโดน Reject  

  

รูปที ่2. 27 ตวัอยา่งการใชง้าน ISD Input Stage เพื่อดึงขอ้มูลจาก Web Service *15 
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6. Big Data Processing [16] 

ในหมวดน้ีจะเก่ียวขอ้งกบัการแลกเปล่ียนขอ้มูล จากแหล่งขอ้มูลขนาดใหญ่ 
6.1. Access Data on HDFS (Hadoop Distributed File System) 

คือ การใช ้Big Data File Stage ในการดึงและจดัเก็บขอ้มูลจากไฟล ์HDFS 
6.2. Augment Data with Hadoop-based Analytics 

คือ การใช ้ Hadoop-based analytic ในการประมวลผลก่อน จากนั้นจึงน ามาจดัเก็บในฐานขอ้มูล 
ตวัอยา่ง เช่นในในรูปท่ี 2.29 ขอ้มูลท่ีผา่นการประมวลผลแลว้ จะสามารถเช่ือมต่อได ้ โดยการใช ้
Hive Stage แลว้จึงน าไปจดัเก็บลงฐานขอ้มูล Netezza โดยใช ้Netezza Connector Stage  

 

  

รูปที ่2. 28 ตวัอยา่งการใชง้าน WebSphere MQ Connector Stage *15 

รูปที ่2. 29 ตวัอยา่งเช่ือมต่อระหวา่ง Hive Stage กบั Netezza Connector Stage *16 
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7. Combine Jobs in a Sequence Job [17] 

การน า Job มาต่อกนัเพื่อก าหนดล าดบัการท างาน และวธีิการท างาน เรียกวา่ Sequence Job ซ่ึงมี
ความสามารถในการก าหนด Checkpoint Restart ท าใหส้ามารถ Restart เพื่อท างานต่อจากขั้นท่ีท าส าเร็จ
ขั้นล่าสุดไดท้นัที โดยในรูปท่ี 2.30 Job ตวัอยา่ง ไดมี้การใช ้Job Activity Stage 3 Stage ในการ Extract, 
Transform, Load จากนั้นจึงใช ้Notification Activity Stage ในการส่งขอ้ความเตือนต่อไป ซ่ึงในตวัอยา่ง
ยงัมีการใช ้Exception Handler Stage ในการรองรับกรณีท่ีเกิด Error ต่าง ๆ โดยเม่ือมี Error เกิดข้ึน ก็จะ
ท างานตาม Routine Activity Stage  

 

 

  

รูปที ่2. 30 ตวัอยา่งการน า Job ต่าง ๆ มาจดัเรียงเป็น Sequence Job *17 
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บทที ่3 
แผนงานการปฏิบัตงิานและขั้นตอนการด าเนินงาน 

 ในบทน้ีจะกล่าวถึงแผนการปฏิบติังาน ซ่ึงจะเจาะจงการท าโครงงานเป็นหลกั เน่ืองจากงานท่ีไดรั้บ
มอบหมายต่าง ๆ นั้นเป็นการสนบัสนุนการท างานของพนกังานภายในแผนกเป็นหลกั และมีผลกบัโครงงาน
ท่ีท า ทั้งทางตรงและทางออ้ม ซ่ึงผลลพัธ์ท่ีไดข้องโครงงานน้ี คือ User Manual ซ่ึงมีความแตกต่างจากคู่มือ
ของทาง IBM® เน่ืองจากโครงงานช้ินน้ีเนน้ท่ีการตั้งค่าต่าง ๆ ของ Stage มากกวา่คู่มือของทาง IBM® ซ่ึงมี
ลกัษณะเป็นการท าตามขั้นตอนท่ีก าหนด 

3.1 แผนงานการปฏบิัติงาน 
 

ตารางที ่3. 1 Gantt Chart ของแผนงานการปฏิบติังาน 

งานท่ีปฏิบติั มิถุนายน กรกฎาคม สิงหาคม กนัยายน 
1. ศึกษาและท าความเขา้ใจ BI Concept                   
2. ศึกษาโปรแกรมอ่ืนท่ีใชใ้นการท า BI                   
3. ศึกษา Concept ของ DataStage®                   
4. ท าเอกสารแนะน า DataStage®                   
5. ศึกษาการใชง้าน Stage ต่าง ๆ ของ 

DataStage® 
                  

6. น าเสนอวธีิการใชง้าน Stage ต่าง ๆ ของ 
DataStage® 

                  

7. จดัท าคู่มือการใชง้าน DataStage®                   
8. ตรวจสอบคู่มือ DataStage®                   
9. แกไ้ขปรับปรุงคู่มือ DataStage®                   
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3.2 รายละเอยีดทีนั่กศึกษาปฏบิัติในการปฏบิัติงาน 
 เน่ืองจากผูจ้ดัท าโครงงานไดเ้ขา้ร่วมสหกิจในช่วงท่ีแผนก Academy & BI ไม่ค่อยไดรั้บการแจง้
ปัญหาจากลูกคา้ และยงัอยูใ่นช่วงการท า MA ใหก้บัลูกคา้ ดงันั้นผูจ้ดัท าโครงงานจึงไดรั้บมอบหมายใหท้ า
การตรวจสอบรายงานต่าง ๆ ของลูกคา้ และท าการศึกษาเคร่ืองมือต่าง ๆ ท่ีลูกคา้ใชง้าน เพื่อเตรียมความ
พร้อมในการรับมือกบัการแกไ้ขปัญหาท่ีไดรั้บแจง้จากลูกคา้ นอกจากน้ียงัไดรั้บมอบหมายโครงงานในการ
ท าการสาธิตกระบวนการ ETL ของระบบ Business Intelligence ดว้ยโปรแกรม IBM® InfoSphere® 
DataStage® ซ่ึงเป็นโปรแกรมท่ีใชใ้นการแปรรูปขอ้มูล เน่ืองดว้ยศกัยภาพในการประมวลผลท่ีสูงของ 
IBM® InfoSphere® DataStage® จึงท าใหท้างผูป้ระกอบการตอ้งการทราบถึงความสามารถของโปรแกรม 
รวมถึงวธีิการใชง้าน เพื่อน ามาเปรียบเทียบกบัโปรแกรมอ่ืน ๆ ท่ีทางสถานประกอบการไดเ้ป็นตวัแทน
จ าหน่ายต่อไป 

 

3.3 ขั้นตอนการด าเนินงานทีนั่กศึกษาปฏบิัติงาน 
3.3.1 ศึกษาและท าความเข้าใจ BI Concept 

ศึกษา Concept ต่าง ๆ ท่ีเก่ียวขอ้งกบัการท า BI ไดแ้ก่ Data Source, Data Warehouse, ETL, ELT, Cube, และ 
Report เพื่อเป็นการท าความเขา้ใจกระบวนการท างานขั้นพื้นฐาน 

 

3.3.2 ศึกษาโปรแกรมอ่ืนทีใ่ช้ในการท า BI 

ศึกษาซอฟตแ์วร์ต่าง ๆ เช่น Oracle Warehouse Builder 11g, IBM® Cognos Analytics, Oracle Business 
Intelligence Enterprise Edition 12c เพื่อสนบัสนุนการท างานของแผนก และท าความเขา้ใจกบักระบวนการ
ต่าง ๆ ซ่ึงรวมทั้งการติดตั้ง 
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3.3.3 ศึกษา Concept ของ DataStage® 

ศึกษา Concept ต่าง ๆ ของ DataStage® ตวัอยา่งเช่น Parallelism, Data Pipelining, Data Partitioning, 
Dynamic Repartitioning, Data Repartitioning ซ่ึงช่วยในการท าความเขา้ใจกระบวนการรูปแบบการท างาน
ต่าง ๆ ของ Stage ภายใน DataStage® 

 

3.3.4 จัดท าเอกสารแนะน า DataStage® 

จดัท าเอกสารเพื่อแนะน าความสามารถและอธิบาย Concept ต่าง ๆ ของ DataStage® 

 

3.3.5 ศึกษาการใช้งาน Stage ต่าง ๆ ของ DataStage® 

ศึกษาการใชง้าน Stage ต่าง ๆ  ของ DataStage® โดยประกอบไปดว้ย Stage ต่าง ๆ  ดงัน้ี DB2 Connector Stage, 
Unstructured Data Stage, Sequential File Stage, Transformer Stage, Sort Stage, Remove Duplicates Stage, 
Aggregator Stage, Checksum Stage, Row Generator Stage, Peek Stage, Sample Stage, Filter Stage, Funnel 
Stage, Lookup Stage, Join Stage, Merge Stage, Difference Stage, Change Capture Stage, Change Apply 
Stage, และ Pivot Enterprise Stage ซ่ึง Stage ต่าง ๆ ท่ีเลือกมาลว้นแต่เป็น Stage พื้นฐาน ท่ีมีแนวโนม้จะใช้
งานสูง หรือเป็น Stage ท่ีเป็นเอกลกัษณ์ของ DataStage® 

 

3.3.6 น าเสนอวธีิการใช้งาน Stage ต่าง ๆ ของ DataStage® 

น าเสนอวธีิการใชง้านต่อพนกังานท่ีปรึกษา โดยเจาะจงไปท่ีความสามารถของ Stage ต่าง ๆ รวมถึงขอ้มูล
ก่อนการแปรรูป และขอ้มูลหลงัการแปรรูป 
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3.3.7 จัดท าคู่มือการใช้งาน DataStage® 

จดัท าคู่มืออธิบายการตั้งค่า Stage ต่าง ๆ ของ DataStage® พร้อมทั้งตวัอยา่งการใชง้านและผลลพัธ์
ประกอบการอธิบาย 

 

3.3.8 ตรวจสอบคู่มือ DataStage® 

น าคู่มือการใชง้านท่ีจดัท ามาใชง้าน เพื่อเป็นการตรวจสอบความถูกตอ้งของคู่มือท่ีไดจ้ดัท าข้ึน 

 

3.3.9 แก้ไขปรับปรุงคู่มือ DataStage® 

ปรับปรุงคู่มือท่ีจดัท า ใหมี้ความถูกตอ้งแม่นย  ามากข้ึน รวมทั้งปรับปรุงตามความเหมาะสมตามท่ีไดป้รึกษา
กบัพนกังานท่ีปรึกษา 
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บทที ่4 
สรุปผลการด าเนินงาน การวเิคราะห์และสรุปผลต่าง ๆ 

4.1 ส่วนประกอบต่าง ๆ ของ IBM® InfoSphere® DataStage® 
4.1.1 Parallel and Sequential 

ในการท างานของ DataStage® นั้นจะมีวธีิประมวลผล 2 แบบ คือ Parallel และ Sequential ซ่ึงการประมวลผล
แบบ Parallel นั้นจะมีการประมวลผลท่ีรวดเร็วกวา่ เน่ืองจากมีการแบ่งขอ้มูลออกเป็น Partition โดยไม่มี
ผลกระทบต่อการค านวณและการตีความขอ้มูล ซ่ึงทาง IBM® ไดส้ร้างตรรกะในการแบ่ง Partition เอาไวใ้ห้
แลว้ ดงันั้นผูใ้ชจึ้งไม่จ  าเป็นตอ้งจดัท าเอง แต่การประมวลผลแบบ Parallel นั้น บางคร้ังจะไดผ้ลลพัธ์แตกต่าง
จากท่ีตอ้งการ ตวัอยา่งเช่น Sort Stage เหมือนดัง่รูปท่ี 4.1 ซ่ึงทางซา้ยคือการใช ้Sort Stage ท่ีก าหนดใหท้ างาน
แบบ Sequential ในขณะท่ีทางขวาคือ Sort Stage ท่ีก าหนดใหท้ างานแบบ Parallel โดยสามารถก าหนด
รูปแบบการท างานไดโ้ดยการ Double Click Stage ท่ีตอ้งการก าหนด แลว้เลือก Tab Stage > Advance ซ่ึงใน
กรณีท่ีมี Preserve Partitioning มีค่าเป็น Default(Set) หรือ Set ก็จ  าเป็นจะตอ้งเปล่ียนเป็น Clear เสียก่อน ดงั
รูปท่ี 4.2 และ 4.3 

 

  

รูปที ่4. 1 ตวัอยา่งการใช ้Sort Stage ดว้ยการประมวลผลแบบ Sequential (ซา้ย) และแบบ Parallel (ขวา) 
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4.2 Canvas 

เม่ือท าการเปิดโปรแกรม InfoSphere® DataStage® Designer และท าการ Log In แลว้จะเขา้มาท่ีหนา้ต่างดงั
รูปท่ี 4.4 ใหเ้ลือก Parallel Job ก็จะปรากฏ Canvas ส าหรับออกแบบ Parallel Job ดงัรูปท่ี 4.5 

 

 

รูปที ่4. 2 ตวัอยา่งการตั้งค่า Preserve Partitioning เป็น Clear 

รูปที ่4. 3 สัญลกัษณ์การเปล่ียนรูปแบบการประมวลผลจาก Sequential เป็น Parallel (วงกลม
ทางซา้ย) และเปล่ียนแปลงจาก Parallel เป็น Sequential (วงกลมทางขวา) 
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รูปที ่4. 4 หนา้ค่างเลือกประเภทงานท่ีจะสร้าง 

รูปที ่4. 5 Canvas ของ Parallel Job 
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ในส่วนของ menu bar ดา้นบนจะมี icon 2 อนัท่ีใชใ้นการก าหนดเก่ียวกบั grid ดงัรูปท่ี 4.6 – 4.10 

  

 

รูปที ่4. 6 ต าแหน่งของ Show grid lines และ Snap to grid 

รูปที ่4. 8 เปิดใช ้Show grid lines เพื่อแสดงเส้นตาราง 

รูปที ่4. 7 เปิดใช ้Snap to grid เพื่อล็อคให ้stage ต่าง ๆอยูใ่นกรอบ 

รูปที ่4. 10 เม่ือไม่ไดเ้ปิดใช ้Snap to grid 

รูปที ่4. 9 เม่ือเปิดใช ้Snap to grid 
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4.1.3 Repository 

ในการสร้าง Folder ใน Repository สามารถท าไดโ้ดย คลิกขวาท่ี repository แลว้เลือก New > Folder  
ดงัรูปท่ี 4.11 

 

จากนั้นท าการตั้งช่ือ Folder ดงัรูปท่ี 4.12 

 

รูปที ่4. 11 วธีิการสร้างโฟลเดอร์ใหม่ 

รูปที ่4. 12 ตั้งช่ือโฟลเดอร์ใหม ่
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ในรูปท่ี 4.13 จะสังเกตไดว้า่ โฟลเดอร์ท่ีถูกสร้างมา นั้น จะไม่ถูกเรียงตามตวัอกัษร 

 

เลือก repository ใน menu bar จากนั้นเลือก refresh เพื่อใหโ้ฟลเดอร์ท่ีสร้างข้ึนใหม่ถูกจดัเรียงตามตวัอกัษร 
ดงัรูปท่ี 4.14 

 

  

รูปที ่4. 13 เม่ือสร้างโฟลเดอร์เสร็จและยงัไม่ท าการรีเฟรช 

รูปที ่4. 14 วธีิการ Refresh Repository และผลลพัธ์ 
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4.1.4 Data Connection 

ใน DataStage® นั้น สามารถท่ีจะ save Data Connection ได ้ซ่ึง Data Connection ก็คือขอ้มูลท่ีเก็บรายละเอียด
การเช่ือมต่อเก่ียวกบัฐานขอ้มูล ซ่ึงสามารถท าไดโ้ดยการคลิกขวาในหนา้ต่าง Repository จากนั้นจึงเลือก 
New > Other > Data Connection ดงัรูปท่ี 4.15 

 

กรอกช่ือท่ีตอ้งการจะบนัทึกในช่อง Data Connection Name แลว้จึงเลือก Tab Parameters ดงัรูปท่ี 4.16 

รูปที ่4. 15 สร้าง Data Connection ใหม่ 

รูปที ่4. 16 ก าหนดช่ือ Data Connection 
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กดท่ีปุ่ม ellipsis ดงัรูปท่ี 4.17 

 

จากนั้นเลือกรูปแบบของฐานขอ้มูลท่ีตอ้งการเช่ือมต่อ (ในกรณีน้ีเลือก DB2 Connector) แลว้กดปุ่ม Open 

(โดย Connector ต่าง ๆจะอยูใ่นโฟลเดอร์ Stage Types > Parallel > Database) ดงัรูปท่ี 4.18 

รูปที ่4. 17 Data Connection Tab Parameter 

รูปที ่4. 18 เลือกประเภทของ Connector 
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กรอก Connection Name, Username ในช่องวา่ง 

เม่ือคลิกเพื่อจะกรอก Password จะมีหนา้ต่างข้ึนมาดงัรูปท่ี 4.19 ก็กรอกรหสั 2 คร้ัง แลว้กด OK 

 

แลว้กด OK อีกคร้ัง ก็จะมีหนา้ต่างเปิดข้ึนมา เพื่อใหก้ าหนด Path ท่ีจะท าการ Save Data Connection ดงัรูปท่ี 
4.20 

 

 

รูปที ่4. 19 ช่องกรอกรหสัระหวา่งท า Data Connection 

รูปที ่4. 20 Path ท่ีตอ้งการบนัทึก Data Connection 
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เม่ือกด Save ก็จะมี Data Connection ใน Path ท่ีไดก้  าหนดไว ้ดงัรูปท่ี 4.21 

 

4.1.5 Create Parallel Job 

Parallel Job สามารถสร้างไดโ้ดย คลิกขวาภายใน repository หรือกด File > New > Parallel Job ใน menu bar 
ดงัรูปท่ี 4.22 

 

รูปที ่4. 21 เม่ือเสร็จส้ินการบนัทึก Data Connection 

รูปที ่4. 22 วธีิการสร้าง Parallel Job ใหม่ 
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เม่ือเลือกแลว้ก็จะปรากฏ canvas ของ parallel job ดงัรูปท่ี 4.23 

 

บนัทึก Parallel Job ไดโ้ดยการเลือก File > Save As… ดงัรูปท่ี 4.24 

 

รูปที ่4. 23 Canvas ของ Parallel Job 

รูปที ่4. 24 การบนัทึก Parallel Job 
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ตั้งช่ือ Parallel Job และก าหนด Path ท่ีตอ้งการบนัทึกแลว้กดปุ่ม Save ดงัรูปท่ี 4.25 

Parallel Job ท่ีท าการบนัทึกจะปรากฏใน repository ดงัรูปท่ี 4.26 

รูปที ่4. 25 ก าหนด Path ท่ีตอ้งการท าการบนัทึก Parallel Job 

รูปที ่4. 26 เม่ือเสร็จส้ินการบนัทึก Parallel Job 
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4.1.6 Table Definition 

ใน DataStage® Stage ต่าง ๆ จะมี Tab Output หรือ Input หรือทั้งสองอยา่ง ข้ึนอยูก่บัการออกแบบ โดยใน 
Tab เหล่าน้ีจะมี Tab Columns ท่ีจะก าหนดประเภทและขนาดของขอ้มูลต่าง ๆ ท่ีท าการน าเขา้มาภายในหรือ
ส่งออกจาก Stage นั้น ๆ ซ่ึงค่าท่ีตั้งนั้น สามารถบนัทึกเป็น Table Definition และสามารถน ามา Load เพื่อลด
ระยะเวลาในการตั้งค่าได ้ดงัรูปท่ี 4.27 โดยการตั้งค่าต่าง ๆ นั้น จะถูกผกูกบั Link ท่ีท  าอยู ่ดงันั้น ถา้ลบ Link 
ก็จะตอ้งท าการตั้งค่าในส่วนน้ีใหม่   

 

 

  

รูปที ่4. 27 ตวัอยา่ง Data Definition 
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4.2 วธีิการใช้งาน Stage ต่าง ๆ ของ DataStage® 
Stage ต่าง ๆ ส าหรับการใชง้านใน Parallel Job สามารถหาไดใ้น DSProject > Stage Types > Parallel ดงัรูป
ท่ี 4.28 

 

ซ่ึงจะมีการกล่าวถึงการตั้งค่าและการใชง้าน Stage ต่าง ๆ เรียงตามล าดบัดงัต่อไปน้ี 

1. DB2 Connector Stage (Read) 
2. DB2 Connector Stage (Write) 
3. Unstructured Data Stage (Read) 
4. Unstructured Data Stage (Write) 
5. Sequential File Stage (Read) 
6. Sequential File Stage (Write) 
7. Transformer Stage 
8. Sort Stage 
9. Remove Duplicates Stage 
10. Aggregator Stage 

รูปที ่4. 28 ต  าแหน่งโฟลเดอร์ต่าง ๆ ท่ีบรรจุ Stage ส าหรับ Parallel Job 
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11. Checksum Stage 
12. Row Generator Stage 
13. Peek Stage 
14. Sample Stage 
15. Filter Stage 
16. Funnel Stage 
17. Lookup Stage 
18. Join Stage 
19. Merge Stage 
20. Difference Stage 
21. Change Capture Stage 
22. Change Apply Stage 
23. Pivot Enterprise Stage 

การเพิ่ม Stage ลงไปใน Canvas ท าไดโ้ดยลากจาก Repository ลงไปท่ี Canvas โดยตรง เม่ือมี Stage ต่าง ๆ 
บน Canvas แลว้ ก็ตอ้งท าการสร้าง Link เพื่อเช่ือมต่อ ซ่ึงสามารถท าไดโ้ดยการคลิกท่ี Stage ตน้ทาง เพื่อให้
ข้ึนขอบรอบ ๆ Stage ท่ีเลือก แลว้น า Cursor ไปวางไวบ้นขอบ ซ่ึง Cursor จะเปล่ียนเป็นรูป วงกลมสีด าสอง
วงซอ้นกนั แลว้จึงลากไปยงั Stage ปลายทาง ซ่ึงการตั้งค่า Stage ต่าง ๆ จะสัมพนัธ์กบัทิศทางของ Link 

นอกจากน้ี Stage ต่าง ๆ ของ DataStage® ยงัสามารถเจาะจงรูปแบบการประมวลผลวา่จะใหเ้ป็นรูปแบบ 
Sequential หรือ Parallel ซ่ึงสามารถเลือกใชไ้ดต้ามความเหมาะสม ซ่ึงการตั้งค่าน้ี สามารถพบไดใ้น  
Tab Stage > Advance ซ่ึงในบาง Stage ช่อง Preserve partitioning มีค่า Default เป็น Set ก็ตอ้งแกไ้ขใหเ้ป็น 
Clear ดงัรูปท่ี 4.29 
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4.2.1 DB2 Connector Stage (Read) 

 

เม่ือท าการลาก DB2 Connector Stage ลงมาใน Canvas ดงัรูปท่ี 4.30 และมีการก าหนด Link ใหน้ าขอ้มูลออก 
จะมีการตั้งค่าต่าง ๆ ดงัรูปท่ี 4.31 ดงัน้ี 

Connection  ส่วนท่ีเจาะจงการเช่ือมต่อเขา้กบัฐานขอ้มูล เม่ือท าการกรอกแลว้ สามารถบนัทึกไวใ้น

รูปแบบ Data Connection ท าใหส้ามารถ Load การตั้งค่าต่าง ๆ มาใชไ้ดท้นัที เม่ือท าการกรอกขอ้มูลครบถว้น
แลว้ สามารถกดท่ีปุ่ม Test เพื่อท าการทดสอบการเช่ือมต่อได ้

View Data สามารถใชเ้พื่อดูตวัอยา่งขอ้มูลท่ีจะท าการเรียกออกมาได ้ดงัรูปท่ี 4.32 

Generate SQL  ถา้เลือกเป็น Yes จะท าการเปิดช่อง Table name และปิดช่อง Select statement ผลลพัธ์ท่ีได้
คือ select * from [Table name] 

รูปที ่4. 29 การ Clear Preserve Partitioning เพื่อรองรับการประมวลผลแบบ Sequential 

รูปที ่4. 30 รูป DB2 Connector Stage (Output) 
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Prefix for expression columns  ก าหนดช่ือใหค้อลมัน์ท่ีเกิดจากการค านวณดว้ย Select statement 

Select statement ผูใ้ชส้ามารถก าหนดเง่ือนไขส าหรับการเรียกขอ้มูลไดโ้ดยตรง 

Fail on size mismatch จะยกเลิกการท างานถา้ขนาดของคอลมัน์ท่ีก าหนดใน DataStage® ไม่เหมือนกบัท่ี
ก าหนดไวใ้นฐานขอ้มูล 

Fail on type mismatch จะยกเลิกการท างานถา้ประเภทของคอลมัน์ท่ีก าหนดใน DataStage® ไม่เหมือนกบั
ท่ีก าหนดไวใ้นฐานขอ้มูล 

 

 

 

รูปที ่4. 31 Output Properties ของ DB2 Connector Stage 
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4.2.2 DB2 Connector Stage (Write) 

 

เม่ือท าการลาก DB2 Connector Stage ลงมาใน Canvas ดงัรูปท่ี 4.33 และมีการก าหนด Link ใหน้ าขอ้มูลเขา้ 
จะมีการตั้งค่าต่าง ๆ ดงัรูปท่ี 4.34 ดงัน้ี 

  

รูปที ่4. 32 ตวัอยา่งการ View Data ดว้ย DB2 Connector Stage 

รูปที ่4. 33 รูป DB2 Connector Stage (Input) 
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Connection  ส่วนท่ีเจาะจงการเช่ือมต่อเขา้กบัฐานขอ้มูล เม่ือท าการกรอกแลว้ สามารถบนัทึกไวใ้น

รูปแบบ Data Connection ท าใหส้ามารถ Load การตั้งค่าต่าง ๆ มาใชไ้ดท้นัที เม่ือท าการกรอกขอ้มูลครบถว้น
แลว้ สามารถกดท่ีปุ่ม Test เพื่อท าการทดสอบการเช่ือมต่อได ้

View Data สามารถใชเ้พื่อดูตวัอยา่งขอ้มูลท่ีอยูภ่ายในฐานขอ้มูลได ้

Write mode ก าหนดรูปแบบของการบนัทึกขอ้มูล เช่น Insert, Insert new rows only, Update, Delete, 
Insert then update, Update then insert, Delete then insert เป็นตน้ 

Generate SQL  ถา้เลือกเป็น Yes ปิดช่อง Select statement และจะสร้างโคด้ใหส้ัมพนัธ์กบัการตั้งค่าอ่ืน ๆ 

Prefix for expression columns  ก าหนดช่ือใหค้อลมัน์ท่ีเกิดจากการค านวณดว้ย Select statement 

SQL statement  ผูใ้ชส้ามารถก าหนดเง่ือนไขส าหรับการจดัการขอ้มูลไดโ้ดยตรง โดยจะเปิดใหก้  าหนดค่า
ต่าง ๆ ท่ีสัมพนัธ์กบั Write mode 

Table action ก าหนดวธีิการจดัการขอ้มูลใหม่กบั Table ซ่ึงไดแ้ก่ Append, Create, Replace, Truncate 

Fail on size mismatch จะยกเลิกการท างานถา้ขนาดของคอลมัน์ท่ีก าหนดใน DataStage® ไม่เหมือนกบัท่ี
ก าหนดไวใ้นฐานขอ้มูล 

Fail on type mismatch จะยกเลิกการท างานถา้ประเภทของคอลมัน์ท่ีก าหนดใน DataStage® ไม่เหมือนกบั
ท่ีก าหนดไวใ้นฐานขอ้มูล 

Drop unmatched fields ถา้ก าหนดเป็น Yes จะไม่บนัทึกขอ้มูลท่ีมี Field ไม่ตรงกนั 

Fail on row error จะยกเลิกการท างานถา้พบแถวท่ีมีความผดิพลาดระหวา่งการบนัทึก 
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รูปที ่4. 34 Input Properties ของ DB2 Connector Stage 
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4.2.3 Unstructured Data Stage (Read) 

  

Unstructured Data Stage เป็น stage ท่ีใชส้ าหรับการอ่านและเขียนไฟล ์Excel ดงัรูปท่ี 4.35 และรูปท่ี 4.36 ซ่ึง
สามารถตั้งค่าต่างๆไดด้งัน้ี 

 

Stage > Properties 

 Document type [Excel] เลือกประเภทของเอกสาร 

Error action [Fail, Skip] เลือกวธีิการรับมือเม่ือเกิดขอ้ผิดพลาด โดย skip จะไม่หยดุการท างานเม่ือ

เกิดขอ้ผิดพลาด แต่จะอ่านขอ้มูลเท่าท่ีจะสามารถอ่านได ้ ในขณะท่ี Fail จะหยดุการท างานของ Parallel Job 
เม่ือเกิดขอ้ผิดพลาดข้ึนระหวา่งการอ่านขอ้มูล 

  

รูปที ่4. 35 รูป Unstructured Data Stage (Output) 

รูปที ่4. 36 Stage Properties (ซา้ย) และ Output Properties (ขวา) ของ Unstructured Data Stage 
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Output > Properties 

 Skip null rows [Yes, No] การอ่านขอ้มูล จะอ่านแถวท่ีมีค่าเป็น null ทั้งหมดดว้ยหรือไม่ ถา้ตอ้งการ
แถวท่ีมีค่าเป็น null ทั้งหมด ใหท้  าการตั้งค่าเป็น No 

 Hidden columns [Extract, Skip] ก าหนดวา่จะท าอยา่งไรกบัแถวท่ีถูกซ่อนเอาไว ้ระหวา่งอ่านแถวท่ี

ซ่อนเอาไว ้(Extract) หรือขา้มแถวท่ีถูกซ่อน (Skip) 

 

 

1 

2 3 

4 

รูปที ่4. 37 หนา้ต่าง Configure ของ Unstructured Data Stage (Output) 
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จากรูปท่ี 4.37 

ส่วนท่ี 1 คือส่วนท่ีระบุต าแหน่งของไฟลท่ี์ตอ้งการจะอ่านและรหสัของไฟล(์ถา้มี) 

ส่วนท่ี 2 คือส่วนท่ีก าหนดวา่จะท าการอ่านส่วนไหนของไฟล ์โดยจะประกอบไปดว้ยช่ือของ Sheet หมายเลข
แถวและตวัอกัษรประจ าคอลมัน์ พร้อมทั้งระบุวา่แถวแรกของไฟลน์ั้นเป็นช่ือคอลมัน์หรือไม่ ซ่ึงในส่วนน้ีจะ
สอดคลอ้งกบัส่วนท่ี 3 ตวัอยา่งเช่น ถา้ไม่ไดร้ะบุ Range expression และ Sheet names to skip ในส่วนน้ีแลว้
กด Load ส่วนท่ี 3 ก็จะแสดงขอ้มูลส าหรับน าเขา้ทุก Sheet ทุกคอลมัน์ ซ่ึงเม่ือสั่ง Import ในส่วนท่ี 3 ช่อง 
Range expression ของส่วนน้ีก็จะท าการก าหนดให้โดยอตัโนมติั 

ส่วนท่ี 3 ในส่วนน้ีจะท าการเลือกคอลมัน์ท่ีตอ้งการน าขอ้มูลมาใช ้ โดยท าการท าเคร่ืองหมายถูกท่ีคอลมัน์ท่ี
ตอ้งการแลว้จึงกด Import ก็จะท าการส่งช่ือคอลมัน์ต่อไปในส่วนท่ี 4 

ส่วนท่ี 4 ส่วนน้ีมีไวเ้พื่อจบัคู่ขอ้มูลระหวา่งคอลมัน์ของ Excel และคอลมัน์ท่ีไดก้ าหนดไวใ้น Table 
Definition ของทาง DataStage® โดยค่าท่ีน าเขา้สามารถระบุไดว้า่ใหเ้ก็บเป็นรูปแบบใด ตวัอยา่งเช่น 
expression ของ excel 

4.2.4 Unstructured Data Stage (Write) 

 

Unstructured Data Stage ในฝ่ังการบนัทึก จะมีการบนัทึกค่าตามรูปแบบท่ีไดต้ั้งไวใ้น Table Definition ดงัรูป
ท่ี 4.38 ตวัอยา่งเช่น ถา้ตั้งค่าคอลมัน์เป็น VarChar เม่ือท าการบนัทึกลง Excel ก็จะถือวา่เป็นขอ้ความ ไม่ใช่
ตวัเลข ดงันั้นจึงไม่สามารถท าการค านวนได ้โดยการบนัทึกจะมีการตั้งค่าท่ีแตกต่างออกไปดงัน้ี 

รูปที ่4. 38 รูป Unstructured Data Stage (Input) 
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Stage > Properties   

จาก Error action จะเปล่ียนเป็น Excel > Write mode ซ่ึงสามารถเลือกไดส้องแบบคือการแกไ้ขไฟลท่ี์มีอยูแ่ลว้ 
(Modify an existing file) และสร้างไฟลใ์หม่ (Create a file) ดงัรูปท่ี 4.39 

Configure 

ในส่วนของหนา้ต่าง configure นั้น แตกต่างจากขั้นตอนการอ่านโดยส้ินเชิง โดยจะประกอบดว้ยส่วนต่าง ๆ 
ดงัน้ี 

  

รูปที ่4. 39 Stage Properties ของ Unstructured Data Stage (Input) 
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จากรูปท่ี 4.40 ส่วนท่ี 1 เป็นส่วนท่ีระบุวธีิการบนัทึกขอ้มูลลงบนไฟล ์พร้อมทั้งต าแหน่งของไฟล ์และวธีิการ
อพัเดท โดยวธีิการบนัทึกจะมีแบบบนัทึกลงไฟลท่ี์เจาะจง (Specific file) และบนัทึกแบบสร้างหลายไฟล ์
(Generate multiple files) โดยการสร้างแบบหลายไฟล ์จะตอ้งก าหนดจ านวนแถวสูงสุดต่อ Excel Sheet ซ่ึง
การตั้งค่าในส่วนน้ีจะแสดงข้ึนมาอยูใ่นส่วนท่ี 2 ส่วนวธีิการอพัเดทจะประกอบดว้ยการอพัเดท (Update) และ
สร้างใหม่ (Create (Error if exists)) ซ่ึงการสร้างใหม่จะไม่สามารถท าไดใ้นกรณีท่ีมีไฟลช่ื์อเดียวกนั 

ส่วนท่ี 2 ใชใ้นการก าหนดการบนัทึกหวัคอลมัน์และการปรับขนาดของคอลมัน์ตามขนาดของขอ้มูล 

ส่วนท่ี 3 ใชใ้นการจบัคู่ Link ของ DataStage® กบั Sheet ของ Excel  

1 2 

3 

รูปที ่4. 40 หนา้ต่าง Configure ของ Unstructured Data Stage (Input) 
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4.2.5 Sequential File Stage (Read)  

 

Stage น้ี ใชส้ าหรับการอ่านไฟลท่ี์เป็นขอ้ความหรือไฟล ์txt ดงัรูปท่ี 4.1 ซ่ึงการใชง้านนั้น หลกั ๆ แลว้จะตอ้ง
ก าหนดต าแหน่งของไฟล,์ table definition ซ่ึง Stage น้ียงัรองรับการอ่านช่ือคอลมัน์ ดงัรูปท่ี 4.2 ในกรณีท่ี
ขอ้มูลแถวแรกเป็นช่ือคอลมัน์ ซ่ึงท าไดโ้ดยแก ้First Line is Column Names = True 

รูปที ่4. 41 รูป Sequential File Stage (Output) 

รูปที ่4. 42 Output Properties ของ Sequential File Stage 
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4.2.6 Sequential File Stage (Write)  

 

รูปท่ี 4.43 คือตวัอยา่งของการจดัวาง Sequential File Stage เพื่อใชใ้นรูปแบบการบนัทึกไฟล ์ ซ่ึงมีหนา้ต่าง
การตั้งค่าดงัรูปท่ี 4.44 และผลลพัธ์ดงัรูปท่ี 4.45 

File ระบุต าแหน่งของไฟล ์ช่ือไฟล ์และประเภทของไฟล์ 

File Update Mode [Append, Create (Error if exists), Overwrite] ก าหนดวธีิการจดัการไฟล ์ไดแ้ก่ เขียนต่อ
จากของเดิม สร้างใหม่ซ่ึงไม่สามารถสร้างไดห้ากมีไฟลช่ื์อซ ้ ากนั และเขียนทบัของเก่าตามล าดบั 

Write Method [Specific File(s), Generate Multiple Files] ก าหนดวธีิการบนัทึกโดยจะแบ่งเป็น บนัทึกขอ้มูล
บนไฟลท่ี์เจาะจง และสร้างไฟล์ข้ึนมาหลายๆไฟล ์ในกรณีท่ีตอ้งการแยกขอ้มูลไปในแต่ละไฟล ์

Cleanup On Failure [True, False] ในกรณีท่ีตั้งค่าเป็น True ระบบจะท าการลบค่าท่ีบนัทึกไปแลว้บางส่วน
ในกรณีท่ีเกิดการท างานผดิพลาด ส่งผลใหไ้ฟลน์ั้นมีลกัษณะเหมือนก่อนเร่ิมท าการบนัทึกขอ้มูล 

First Line is Column Names [True, False] ระบุวา่ตอ้งการใหบ้นัทึกช่ือคอลมัน์เป็นขอ้มูลแถวแรกหรือไม่ 

Reject Mode [Continue, Fail, Output] ในกรณีท่ีเจอขอ้มูลท่ีไม่สามารถจดัเก็บได ้เช่น ขอ้มูลไม่ตรงกบั table 

definition ท่ีไดร้ะบุไว ้ ก็สามารถเลือกวธีิรับมือไดส้ามวิธี ไดแ้ก่ ไม่บนัทึกขอ้มูลส่วนท่ีมีปัญหา ยกเลิกการ
ท างาน และส่งต่อขอ้มูลท่ีมีปัญหาไปให ้Stage ถดัไป 

 

 

 

รูปที ่4. 43 รูป Sequential File Stage (Input) 
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รูปที ่4. 44 Input Properties ของ Sequential File Stage 
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รูปที ่4. 45 ตวัอยา่งขอ้มูลท่ีบนัทึกดว้ย Sequential File Stage 
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4.2.7 Transformer Stage 

 

Stage ดงัรูปท่ี 4.46 น้ี มีเพื่อการแปรรูปขอ้มูลโดยการใช ้ expression ต่าง ๆ รวมไปถึงการดดัแปลงแกไ้ข
คอลมัน์ ซ่ึงการลบคอลมัน์ใน Stage อ่ืน อาจจะท าใหเ้กิดคอลมัน์ท่ีมีค่า null ทั้งหมด แต่ในการใช ้transformer 
stage จะไม่มีปัญหาในส่วนนั้น นอกจากน้ี ในการประมวลผลของบาง stage ตวัอยา่งเช่น Pivot Enterprise 
Stage จะมีขอ้มูลเป็น array เกินมาจากขอ้มูลส่วนท่ีตอ้งการ ก็ตอ้งใช ้ transformer stage ในการตดัขอ้มูลใน
ส่วนนั้นออก มิฉะนั้นจะไม่สามารถบนัทึกขอ้มูลลงฐานขอ้มูล DB2 ได ้ซ่ึงมีหนา้ต่างการใชง้านดงัรูปท่ี 4.47 

 

1 

2 

รูปที ่4. 46 รูป Transformer Stage 

รูปที ่4. 47 ส่วนประกอบต่าง ๆ ของ Transformer Stage 
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ส่วนท่ี 1 เป็นการแปรรูปขอ้มูล โดยสามารถเลือกขอ้มูลจากฝ่ัง Input ทางซา้ยมือ มาใส่ในช่อง Derivation ทาง
ขวามือเพื่อก าหนดขอ้มูลท่ีจะถูกส่งออกจาก Transformer Stage ซ่ึงในช่องน้ีสามารถท่ีจะระบุ expression ต่าง 
ๆ เพื่อแปรรูปขอ้มูลได ้นอกจากน้ี Transformer Stage ยงัมี Stage Variable ท่ีสามารถก าหนดและน ามาใชไ้ด้
หลายคร้ัง 

ส่วนท่ี 2 คือรูปแบบและขนาดของขอ้มูลท่ีท าการรับเขา้มาซ่ึงอยูท่างฝ่ังซา้ย และขอ้มูลท่ีส่งออกซ่ึงอยูท่างฝ่ัง
ขวา การตั้งค่าสองฝ่ังนั้นไม่จ  าเป็นตอ้งตรงกนัหรือมีจ านวนเท่ากนั 

4.2.8 Sort Stage 

 

Sort Stage ในรูปท่ี 4.48 ใชเ้พื่อจดัเรียงขอ้มูล โดยท่ีผูใ้ชส้ามารถก าหนด Key หรือก็คือคอลมัน์ท่ีตอ้งการใช้
ในการเรียงได ้ ซ่ึงสามารถท่ีจะก าหนดหลาย ๆ Key เพื่อใหเ้รียงล าดบัไดห้ลายชั้น ซ่ึงการเรียงล าดบันั้น
สามารถเลือกไดท้ั้งแบบ จากนอ้ยไปมาก หรือจากมากไปนอ้ยได ้นอกจากน้ี ยงัสามารถก าหนดไดว้า่ Key ท่ี
ใชใ้นการเรียงล าดบั สามารถมีค่าซ ้ ากนัไดห้รือไม่ (Allow Duplicate) ดงัรูปท่ี 4.49 ซ่ึงการตั้งค่าเป็น False จะ
มีตวัเลือกเพิ่มเติมวา่จะท าการเก็บค่าแรกสุดหรือค่าล่าสุดเอาไว ้ แต่อาจจะพบปัญหาคือค่าตั้งตน้ของ Sort 
Stage มี Execution mode เป็น Parallel ซ่ึงท าใหผ้ลลพัธ์ท่ีไดอ้าจจะผิดเพี้ยนไปจากท่ีตอ้งการ ซ่ึงแกไ้ขไดโ้ดย
การปรับเป็น Sequential และปรับการตั้งค่า Preserve partitioning ใหเ้ป็น Clear ดงัรูปท่ี 4.50 

 

 

 

 

รูปที ่4. 48 รูป Sort Stage 
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รูปที ่4. 49 Stage Properties ของ Sort Stage 

 รูปที ่4. 50 Stage Advanced ของ Sort Stage 



69 
 
4.2.9 Remove Duplicates Stage 

Remove Duplicates Stage ดงัรูปท่ี 4.51 ใชส้ าหรับลบ record ท่ีมีขอ้มูลซ ้ ากนั ซ่ึงผูใ้ชเ้พียงแค่ระบุคอลมัน์ท่ี
ไม่ตอ้งการใหมี้ขอ้มูลซ ้ ากนั ดงัรูปท่ี 4.52 โดนการเลือกคอลมัน์ใน Keys that define Duplicates > Key และ
ก าหนดวา่ตอ้งการเก็บ record อนัแรกสุดหรืออนัล่าสุด โดยการตั้งค่าท่ี Option > Duplicate To Retain [First, 
Last]  

รูปที ่4. 51 รูป Remove Duplicates Stage 

รูปที ่4. 52 Stage Properties ของ Remove Duplicates Stage 
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4.2.10 Aggregator Stage 

 

Aggregator Stage ดงัรูปท่ี 4.53 ใชเ้พื่อหาผลรวมของค่าท่ีตอ้งการของกลุ่มต่าง ๆ ซ่ึงตอ้งก าหนดค่าต่าง ๆ ดงั
รูปท่ี 4.54 ดงัน้ี 

Grouping Keys > Group ก าหนดคอลมัน์ท่ีระบุกลุ่ม ท่ีตอ้งการหาผลรวม 

Aggregation > Column for Calculation ก าหนดคอลมัน์ท่ีใชใ้นการค านวน 

Aggregation > Column for Calculation > Sum Output Column ก าหนดคอลมัน์ท่ีตอ้งการใส่ผลลพัธ์ท่ีได ้

Option > Allow Null Output [True, False] ก าหนดวา่ผลลพัธ์สามารถเป็นค่า null ไดห้รือไม่ ถา้ไม่ ก็จะท า
การแทนค่า null ดว้ย 0 

รูปที ่4. 53 รูป Aggregator Stage 

รูปที ่4. 54 Stage Properties ของ Aggregator Stage 
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เม่ือก าหนดวธีิการหาผลรวมเสร็จแลว้ ใน Tab Output > Mapping จะมีการสร้าง Expression ใหโ้ดยอตัโนมติั 
ดงัรูปท่ี 4.55 

  

รูปที ่4. 55 Output Mapping ของ Aggregator Stage 
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4.2.11 Checksum Stage 

 

Checksum Stage ดงัรูปท่ี 4.56 จะท าการสร้างค่า Checksum โดยใชค้่าภายในคอลมัน์ท่ีก าหนดมาค านวณ ซ่ึง
สามารถเลือกไดว้า่จะน าคอลมัน์ทั้งหมดมาค านวณ (Use all columns) น าคอลมัน์ทุกคอลมัน์ยกเวน้คอลมัน์ท่ี
ก าหนดมาค านวณ (Use all columns except those specified) หรือน ามาค านวณเฉพาะคอลมัน์ท่ีก าหนด (Use 
only columns specified) ดงัรูปท่ี 4.57 

รูปที ่4. 56 รูป Checksum Stage 

รูปที ่4. 57 Stage Properties ของ Checksum Stage 
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เม่ือตั้งค่าเสร็จเรียบร้อยแลว้ ก็จะมีคอลมัน์ checksum เพิ่มข้ึนมาส าหรับ Mapping ดงัรูปท่ี 4.58 

 

ซ่ึงเม่ือค านวณแลว้ก็จะมีผลลพัธ์ดงัรูปท่ี 4.59 

 

  

รูปที ่4. 58 Output Mapping ของ Checksum Stage 

รูปที ่4. 59 ตวัอยา่งผลลพัธ์ของ Checksum Stage 
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4.2.12 Row Generator Stage 

 

Row Generator Stage ดงัรูปท่ี 4.60 เป็น Stage ท่ีมีไวส้ร้าง Record ท่ีสุ่มขอ้มูลข้ึนมา ซ่ึง Stage น้ีมีการตั้งค่า
หลกั ๆ คือ จ านวน Record ท่ีตอ้งการ ดงัรูปท่ี 4.61 – 4.62 

 

รูปที ่4. 60 รูป Row Generator Stage 

รูปที ่4. 61 Output Properties ของ Row Generator Stage 
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4.2.13 Peek Stage 

 

Peek Stage ดงัรูปท่ี 4.63 มีความสามารถในการดูขอ้มูลต่าง ๆ  ได ้ซ่ึงสามารถวาง Peek Stage ไวร้ะหวา่ง Stage 
ท่ีตอ้งการดูขอ้มูล ซ่ึงขอ้ดีของ Peek Stage ก็คือ สามารถดูขอ้มูลได ้เม่ือมีการท างานเสร็จแลว้ แมว้า่ Parallel 
Job จะลม้เหลวก็ตาม ซ่ึง Peek Stage จะมีวธีิแสดงผลลพัธ์สองวธีิ ดงัรูปท่ี 4.64 คือ Job Log ดงัรูปท่ี 4.65 – 
4.66 และ Output ดงัรูปท่ี 4.67 – 4.68 ในกรณีท่ีมีการท างานแบบ Parallel Peek Stage จะมีการแบ่งปริมาณ
ออกตามจ านวน Partition ท่ีมี 

Rows > Number of Records (Per Partition) ก าหนดจ านวน record ท่ีใหแ้สดงผลต่อ 1 Partition 

Columns > Peek All Input Columns [True, False] แสดงผลคอลมัน์ทั้งหมดหรือไม่ 

Partitions > All Partitions [True, False] แสดงผลทุก Partition หรือไม่ 

Options > Peek Records Output Mode [Job Log, Output] เลือกรูปแบบของ Output 

รูปที ่4. 62 ตวัอยา่งการใช ้Row Generator Stage ในการ Generate ขอ้มูลในคอลมัน์ Name และ Salary 

รูปที ่4. 63 รูป Peek Stage 
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Options > Show Column Names [True, False] แสดงช่ือของคอลมัน์ในผลลพัธ์ 

 

เม่ือ double click ก็จะเปิดหนา้ต่างดงัรูปดา้นล่าง 

 

รูปที ่4. 64 Stage Properties ของ Peek Stage 

รูปที ่4. 65 ตวัอยา่ง output แบบ Job Log 

รูปที ่4. 66 หนา้ต่างแสดงผลเม่ือเปิด Peek Stage Job Log 
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ตวัอยา่ง output แบบ Output 

 

 

  

รูปที ่4. 67 ตวัอยา่งการวาง Peek Stage แบบ Output 

รูปที ่4. 68 ตวัอยา่งขอ้มูลจาก Database ท่ีบนัทึกผลลพัธ์จาก Peek Stage แบบ Output 
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4.2.14 Sample Stage 

 

Stage ในรูปท่ี 4.69 – 4.71 ใชส้ าหรับการเลือกหรือสุ่มขอ้มูลบางส่วน เพื่อน าไปทดสอบการท างานของระบบ
ต่อไป 

 

Options > Percent ใชก้ าหนดปริมาณขอ้มูลท่ีตอ้งการสุ่มข้ึนมาเป็นตวัอยา่ง (การสุ่มของ DataStage® มาจาก

การค านวณ ท าใหก้ารสุ่มในแต่ละคร้ัง ท่ีมีการตั้งค่าทุกอยา่งเหมือนกนั จะไดผ้ลลพัธ์เหมือนกนั และการ
ก าหนดเป็น Percent ส่วนมาก มกัจะไม่ไดจ้  านวน record ตรงกบัการค านวณตามปกติ เช่น ได ้15 record จาก 
25 Percent ของ 100 Record) 

Options > Percent > Output Link Number ระบุ Link ท่ีจะล าเลียงขอ้มูล ซ่ึงหมายเลขของ Link สามารถดู
ไดท่ี้ Tab Link Ordering 

รูปที ่4. 69 รูป Sample Stage 

รูปที ่4. 70 ตวัอยา่งการใชง้าน Sample Stage 
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Options > Sample Mode [Percent, Period] เป็นวธีิการเลือกสุ่มขอ้มูล ซ่ึงไดแ้ก่ Percent ท่ีไดอ้ธิบายไว้
ขา้งตน้ และ Period ท่ีเป็นการก าหนดให้เลือกตวัอยา่งมาทุก ๆ n แถว 

 

4.2.15 Filter Stage 

 

Stage ในรูปท่ี 4.72 ใชส้ าหรับการกรองขอ้มูลตามเง่ือนไขท่ีผูใ้ชก้  าหนด โดยมีการตั้งค่าต่าง ๆ  
ดงัรูปท่ี 4.73 – 4.74  

Predicates > Where Clause ก าหนด Where Clause Statement ท่ีผูใ้ชต้อ้งการลงไป 

Predicates > Where Clause > Output Link ก าหนด Link ในการส่งต่อขอ้มูลท่ีผา่นเง่ือนไข Where Clause 
ท่ี Output Link เป็นสมาชิก Output Link สามารถดูไดใ้น Link Ordering 

Options > Output Rejects [True, False] สร้าง Link หรือไม่ ส าหรับขอ้มูลท่ีขดัแยง้กบั table definition 

รูปที ่4. 71 Stage Properties ของ Sample Stage 

รูปที ่4. 72 รูป Filter Stage 
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Options > Output Row Only Once [True, False] กรณีท่ีตั้งเป็น True record ท่ีผา่นเง่ือนไขใดเง่ือนไขหน่ึง

แลว้ จะไม่ถูกน าไปประมวลผลกบั Where Clause อ่ืนซ ้ า ในขณะท่ี ถา้ตั้งเป็น False จะน า record ไป
ประมวลผลกบัทุก Where Clause ซ่ึงถา้ถูกหลาย Where Clause ก็จะท าใหมี้ record ซ ้ ากนัได ้

 

 

  

รูปที ่4. 73 Stage Properties ของ Filter Stage 

รูปที ่4. 74 ตวัอยา่งการใช ้Filter Stage แบบ Multiple Link 
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4.2.16 Funnel Stage 

 

Stage ในรูปท่ี 4.75 ใชส้ าหรับการรวมแถวเขา้ดว้ยกนั โดยรูปท่ี 4.76 จะเห็นไดว้า่ มี Input Link เขา้มาใน 
Funnel Stage จ านวน 2 Link ซ่ึงประกอบไปดว้ยขอ้มูลจ านวน 5 แถว และขอ้มูลจ านวน 10 แถว และมี 1 
Output Link ท่ีมีขอ้มูลจ านวน 15 แถว 

 

 

รูปที ่4. 75 รูป Funnel Stage 

รูปที ่4. 76 ตวัอยา่งการใช ้Funnel Stage 
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โดยสามารถก าหนดวธีิการรวมขอ้มูลได ้3 วธีิ ไดแ้ก่ Continuous Funnel, Sequence, และ Sort Funnel ดงัรูป
ท่ี 4.77 

 

ในส่วนของการก าหนด Link Ordering ดงัรูปท่ี 4.78 จะไม่มีผลกบัการใช ้Sort Funnel เน่ืองจาก Stage จะท า
การอ่านขอ้มูลทั้งหมด เพื่อจดัเรียง ท าใหล้ าดบัของขอ้มูลท่ีเขา้มานั้น ไม่ส่งผลต่อผลลพัธ์ แต่การใช ้ Sort 
Funnel นั้น จะมีลกัษณะเหมือนการใช ้Sort Stage ดงันั้น ผูใ้ชค้วรปรับรูปแบบการประมวลผลใหเ้ป็นแบบ 
Sequential เสียก่อน 

 

รูปที ่4. 77 Stage Properties ของ Funnel Stage 

รูปที ่4. 78 Stage Link Ordering ของ Funnel Stage 
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ต่อไปน้ีจะเป็นตวัอยา่งผลลพัธ์ท่ีเกิดจากการใช ้Funnel Stage รูปแบบต่าง ๆ  ซ่ึงใหส้ังเกตท่ีล าดบัการเรียง ของ
คอลมัน์ CLIENT_CD เป็นหลกั 

 รูปท่ี 4.79 เป็นผลลพัธ์จากการใช ้Continuous Funnel ซ่ึงมีการเรียงล าดบัขอ้มูลแบบ Record ใดท่ีประมวลผล
เสร็จก่อน ก็จะถูกบนัทึกก่อน 

 

รูปท่ี 4.80 เป็นผลลพัธ์จากการใช ้Sequence ซ่ึงมีการเรียงล าดบัขอ้มูลโดยเรียงตามล าดบัของ Link Ordering 
ตวัอยา่งเช่น จะท าการรับขอ้มูลจาก Link Ordering ล าดบัท่ี 0 จนครบทั้งหมดก่อน แลว้บนัทึก จากนั้นจึงอ่าน
ขอ้มูลจาก Link Ordering ล าดบัท่ี 1 จนครบ แลว้จึงน าขอ้มูลไปต่อทา้ยขอ้มูลเดิม 

รูปที ่4. 79 ผลลพัธ์จากการใช ้Continuous Funnel 
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รูปท่ี 4.81 เป็นผลลพัธ์จากการใช ้ Sort Funnel ซ่ึงท าการอ่านขอ้มูลทั้งหมดก่อน แลว้จึงท าการจดัเรียงตาม
คอลมัน์ท่ีก าหนดให้เป็น Key แลว้จึงท าการบนัทึกขอ้มูล 

  

รูปที ่4. 80 ผลลพัธ์จากการใช ้Sequence Funnel 

รูปที ่4. 81 ผลลพัธ์จากการใช ้Sort Funnel 
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4.2.17 Lookup Stage 

 

รูปท่ี 4.82 ใชส้ าหรับการ Lookup ขอ้มูลท่ีอยูต่่าง Table เพื่อน ามาประกอบกบัขอ้มูลเก่า เพื่อช่วยใหข้อ้มูลมี
ความสมบูรณ์มากข้ึน ตวัอยา่งเช่นรูปท่ี 4.83 ท่ีน า CAUSE_TYPE_C จาก DSLink22 มาจบัคู่กบั 
CAUSE_TYPE_C จาก DSLink23 แลว้จึงน าขอ้มูลจากคอลมัน์ต่าง ๆ จาก DSLink22 มาแสดง และน า
คอลมัน์ CAUSE_TYPE_N ซ่ึงเป็นช่ือของสาเหตุมาแสดงแทน CAUSE_TYPE_C ซ่ึงเป็นรหสัตวัเลขของ
สาเหตุ โดย Lookup Stage แตกต่างจากการใช ้Join Stage และ Merge Stage ตรงท่ี Lookup Stage นั้นจะเป็น
การน า Reference Table เก็บไวบ้น RAM และไม่มีการ Sort ขอ้มูลก่อนเร่ิมท าการจบัคู่ท  าใหมี้ความเร็วในการ
ประมวลผลท่ีสูง แต่ในกรณีท่ีมีขอ้มูลภายใน Reference Table ปริมาณมาก จะส่งผลใหป้ระสิทธิภาพดอ้ยกวา่ 
Join Stage และ Merge Stage 

รูปที ่4. 82 รูป Lookup Stage 

รูปที ่4. 83 หนา้ต่างการใชง้าน Lookup Stage 
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4.2.18 Join Stage 

 

Stage ในรูปท่ี 4.84 ใชใ้นการ Join table 2 table เขา้ดว้ยกนัซ่ึงสามารถมีไดห้ลาย Input Link แต่มีไดเ้พียงหน่ึง 
Output Link ซ่ึงการประมวลผลในแต่ละคร้ัง Join Stage จะท าการ Sort ขอ้มูลแบบ Ascending ก่อนท่ีจะท า
การ Join ซ่ึงรูปแบบการ Join ท่ีมีใหเ้ลือกนั้น ไดแ้ก่ Full Outer, Inner, Left Outer, Right Outer ซ่ึงส่ิงท่ีตอ้ง
ก าหนดนอกเหนือจากวธีิการ Join คือ Key หรือคอลมัน์ท่ีใชใ้นการ Join ซ่ึงการจะระบุวา่ Input Link ใด เป็น 
Left หรือ Right สามารถดูไดท่ี้ Link Ordering ดงัรูปท่ี 4.85 – 4.91 

 

รูปที ่4. 84 รูป Join Stage 

รูปที ่4. 85 Stage Properties ของ Join Stage 
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รูปที ่4. 86 Stage Link Ordering ของ Join Stage 

รูปที ่4. 87 ตวัอยา่งขอ้มูลของ Left Table (DSLink23) 

รูปที ่4. 88 ตวัอยา่งขอ้มูลของ Right Table (DSLink22) 
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รูปที ่4. 89 ผลลพัธ์จากการใช ้Full Outer Join 

รูปที ่4. 90 ผลลพัธ์จากการใช ้Inner Join 
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4.2.19 Merge Stage 

 

 

 Stage ในรูปท่ี 4.92 ใชใ้นการรวมขอ้มูลเขา้ดว้ยกนั ซ่ึงประกอบดว้ย 1 Master Table และหลาย Update Table 
โดยอาศยั Key หรือคอลมัน์ท่ีตอ้งการในการ Merge ดงัรูปท่ี 4.93 ซ่ึงก่อนจะท าการรวมขอ้มูล จะตอ้งท าการ 
Sort แบบ Ascending เสียก่อน โดยขอ้แตกต่างท่ีชดัเจนกบั Join Stage คือ Merge Stage สามารถมีไดห้ลาย 
Output Link และยงัรองรับการท า Reject Link ซ่ึงจะท าการเก็บ record ท่ีไม่เขา้คู่กบั Master Table แต่จ านวน 

รูปที ่4. 91 ผลลพัธ์จากการใช ้Left Outer Join 

รูปที ่4. 92 รูป Merge Stage 
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Link นั้น จะตอ้งมีจ านวนเท่ากบั Update Table นอกจากน้ี ขอ้มูลใน Update Table จะตอ้งมี Key ท่ีไม่ซ ้ ากนั 
ซ่ึงตวัอยา่งของขอ้มูลตน้ทาง จะแสดงในรูปท่ี 4.94 – 4.95 

 

 

รูปที ่4. 93 Stage Properties ของ Merge Stage 

รูปที ่4. 94 ตวัอยา่งขอ้มูลจากปี 2014 
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จากรูปท่ี 4.96 มีการใช ้Transformer Stage เพื่อท าการก าจดัคอลมัน์ท่ีไม่ตอ้งการออกไป และไดท้  าการแกไ้ข
ช่ือคอลมัน์ เน่ืองจาก Merge Stage จะถือวา่คอลมัน์ท่ีช่ือเหมือนกนันั้น คือคอลมัน์เดียวกนั จึงท าใหเ้ลือก
ขอ้มูลไดจ้าก Input Link ใด Link หน่ึงเท่านั้น ซ่ึงในกรณีน้ี ไดใ้ชค้อลมัน์ CHANNEL_L1_CD เป็น Key ท่ีใช้
ในการ Merge ไดใ้ชช่ื้อจาก Table ปี 2014 และน า CH_WTD14 มาจาก CH_WTD ใน Table ปี 2014 และ 
CH_WTD15 มาจาก CH_WTD ใน Table ปี 2015  

รูปที ่4. 95 ตวัอยา่งขอ้มูลจากปี 2015 

รูปที ่4. 96 Parallel Job ท่ีใชใ้นการทดสอบการท างานของ Merge Stage 
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4.2.20 Difference Stage 

 

Stage ในรูปท่ี 4.97 ใชเ้ปรียบเทียบขอ้มูลวา่มีความแตกต่างกนัหรือไม่ โดยก าหนดคอลมัน์ท่ีจะใชเ้ป็น Key 
เพื่อใชใ้นการจบัคู่เปรียบเทียบ ดงัรูปท่ี 4.98 และก าหนดคอลมัน์ท่ีเป็น Value ท่ีจะใชใ้นการเปรียบเทียบ 
นอกจากน้ียงัตอ้งก าหนดล าดบั Before และ After ใน Link Ordering เน่ืองจาก Difference Stage จะแสดงผล
โดยใชข้อ้มูลจาก Link ท่ีตั้งเป็น Before เป็นพื้นฐาน 

 

รูปที ่4. 97 รูป Difference Stage 

รูปที ่4. 98 Stage Properties ของ Difference Stage 
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ซ่ึงผลลพัธ์ท่ีได ้ ดงัรูปท่ี 4.99 จะออกมาในรูปแบบคอลมัน์ท่ีช่ือ DIFF ซ่ึงจะเก็บค่า 2 หรือ 3 โดย 2 มี
ความหมายคือ Value ท่ีน ามาเปรียบเทียบทั้ง 2 ชุดนั้นเหมือนกนั และ 3 มีความหมายคือ Value ของทั้ง 2 ชุด
ท่ีใชใ้นการเปรียบเทียบนั้น มีค่าแตกต่างกนั ตวัอยา่งเช่นรูปดา้นล่างท่ีมี 1 Record ท่ีมีค่า CH_WTD 
เหมือนกนัทั้งในปี 2014 และปี 2015 จึงท าใหแ้สดงผลลพัธ์ออกมาเป็น 2 

 

4.2.21 Change Capture Stage 

Stage ในรูปท่ี 4.100 ใชใ้นการหาค่าความเปล่ียนแปลงคลา้ย Difference Stage แต่ Change Capture Stage จะ
เก็บค่าเฉพาะ Record ท่ีมีความเปล่ียนแปลงโดยใชข้อ้มูลท่ีมาจาก Link After จาก Link Ordering เป็นพื้นฐาน 
และสามารถใชร่้วมกบั Change Apply Stage ได ้ โดยวิธีการใชง้านจะเหมือน Difference Stage โดยการ
ก าหนดคอลมัน์ Key ท่ีใชใ้นการจบัคู่เพื่อเปรียบเทียบ และก าหนดคอลมัน์ Value เพื่อใชส้ าหรับเปรียบเทียบ 
ดงัรูปท่ี 4.101 และ รูปท่ี 4.102 

รูปที ่4. 99 ตวัอยา่งผลลพัธ์จากการใช ้Difference Stage 

รูปที ่4. 100 รูป Change Capture Stage 
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รูปที ่4. 101 Stage Properties ของ Change Capture Stage 

รูปที ่4. 102 Stage Link Ordering ของ Change Capture Stage 
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จากรูปท่ี 4.103 จะเห็นไดว้า่ขอ้มูลท่ีน ามาเปรียบเทียบนั้นมีทั้งหมด 63 rows แต่เม่ือผา่น Change Capture 
Stage แลว้ จะเหลือเพียง 62 rows ซ่ึงทั้งหมดลว้นเป็น row ท่ีมีการเปล่ียนแปลงค่า 

 

4.2.22 Change Apply Stage 

 

Stage ในรูปท่ี 4.104 ใชส้ าหรับการน าค่าท่ีเปล่ียนแปลงท่ีพบจาก Change Capture Stage มาอพัเดทขอ้มูลเก่า 
โดย Link ท่ีมาจาก Change Capture Stage จะตอ้งอยูใ่น Link Change ใน Link Ordering ซ่ึงการใชง้าน 
Change Apply Stage ท าไดโ้ดยก าหนดคอลมัน์ Key เพื่อใชใ้นการเปรียบเทียบ และคอลมัน์ท่ีมีการ
เปล่ียนแปลง ดงัรูปท่ี 4.105 และ 4.106 

รูปที ่4. 103 ตวัอยา่งการใชง้าน Change Capture Stage 

รูปที ่4. 104 รูป Change Apply Stage 
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รูปที ่4. 105 Stage Properties (ซา้ย) และ Stage Link Ordering (ขวา) ของ Change Apply Stage 

รูปที ่4. 106 ตวัอยา่งผลลพัธ์ท่ีไดจ้ากการใช ้Change Apply Stage 
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รูปท่ี 4.107 เป็นตวัอยา่งของการใช ้ Change Apply Stage โดยก าหนดให้อพัเดทคอลมัน์ CH_WTD, 
YEAR_CD เฉพาะคอลมัน์ท่ีมีความเปล่ียนแปลงของ CH_WTD โดยเปรียบเทียบระหวา่งปี 2014 กบัปี 2015 
โดยในกรอบสีแดงคือค่าท่ีไม่ไดมี้ความเปล่ียนแปลงใด ๆ ทั้งส้ิน 

 

4.2.23 Pivot Enterprise Stage  

 

Stage ในรูปท่ี 4.108 ใชส้ าหรับการ Pivot Table ซ่ึงสามารถท าไดท้ั้งแบบ Vertical และ Horizontal ซ่ึงการท า
แบบ Vertical คือการน าคอลมัน์มาใส่ในรูปแบบแถว ส่วน Vertical คือการน าแถวมาจดัใส่ในคอลมัน์ ซ่ึงใน
ตวัอยา่งน้ีจะเป็นการท า Horizontal Pivot โดยการใชง้าน Pivot Enterprise Stage นั้น จะตอ้งก าหนดรูปแบบ
ของการ Pivot ท่ี Stage > Properties เสียก่อน แลว้จึงมาก าหนด Pivot Properties วา่ตอ้งการใหจ้ดักลุ่มโดย

รูปที ่4. 107 ตวัอยา่งการใชง้าน Change Apply Stage 

รูปที ่4. 108 รูป Pivot Enterprise Stage 
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คอลมัน์ใด และคอลมัน์ใดท่ีตอ้งการท า Pivot แลว้จึงระบุ Array Size ให้เหมาะสม ซ่ึงในรูปท่ี 4.109 ตอ้งการ
จดัใหข้อ้มูลรายเดือน มารวมกนัเป็นรายปี ดงันั้นจึงตั้งค่าไวท่ี้ 12 ซ่ึงก็คือจ านวนเดือน 

 

*ขอ้ควรระวงัของการใช ้ Pivot Enterprise Stage คือผลลพัธ์ท่ีไดน้ั้น จะมีลกัษณะเป็น Array ซ่ึงเก็บลง
ฐานขอ้มูลไม่ได ้โดยมีวธีิการแกไ้ขคือการวาง Transformer Stage ไวห้ลงั Pivot Enterprise Stage ซ่ึงภายใน 
Transformer Stage นั้น เพียงแค่ Mapping Output ใหเ้หมือนกบั Input (ไม่เกิดความเปล่ียนแปลง) 

รูปที ่4. 109 Stage Pivot Properties ของ Pivot Enterprise Stage 
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ตวัอยา่งขอ้มูล ประกอบดว้ยขอ้มูลก่อนการแปรรูป ดงัรูปท่ี 4.110 และขอ้มูลหลงัการแปรรูป ดงัรูปท่ี 4.111 

 

 

 

  

รูปที ่4. 110 ขอ้มูลก่อนแปรรูป 

รูปที ่4. 111 ผลลพัธ์หลงัแปรรูป 
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บทที ่5 
บทสรุปและข้อเสนอแนะ 

 

5.1 สรุปผลการด าเนินงาน 
การด าเนินงานในคร้ังน้ี ผูจ้ดัท าโครงงานไดเ้ร่ิมจากการศึกษา concept ต่าง ๆ ของการท า Business 

Intelligence ซ่ึงมีการวดัผลโดยการตอบค าถามจากพนกังานท่ีปรึกษา พร้อมกบัไดรั้บมอบหมายใหท้ าการ
ตรวจสภาพรายงานของลูกคา้ ซ่ึงพนกังานท่ีปรึกษาก็ไดใ้หท้รัพยากรต่าง ๆ ท่ีจ  าเป็นต่อการท าความเขา้ใจ
ระบบของลูกคา้ จากนั้นจึงไดรั้บมอบหมายโจทยท่ี์ระบุรูปแบบและผลลพัธ์ขอ้มูลต่าง ๆ ท่ีตอ้งการ โดยใหใ้ช ้
SQL ในการท า เพื่อทดสอบความสามารถ และเสริมสร้างความเขา้ใจขั้นตอนการท า ETL 

 ในส่วนของการศึกษาซอฟตแ์วร์ต่าง ๆ นั้น ถูกก าหนดโดยซอฟตแ์วร์ท่ีลูกคา้ใชง้าน จึงท าใหต้อ้ง
ศึกษาหลายซอฟตแ์วร์ดว้ยกนั ซ่ึงจะท าตาม workshop ท่ีไดรั้บ และมีการทบทวนกบัพนกังานท่ีปรึกษาเป็น
ระยะ แลว้จึงท าการทดสอบโดยการตอบค าถามของพนกังานท่ีปรึกษา ซ่ึงช่วยส่งเสริมความเขา้ใจใน
ซอฟตแ์วร์ท่ีเก่ียวขอ้งกบั BI มากยิง่ข้ึน 

 สุดทา้ยน้ีคือการศึกษาและจดัท าคู่มือการใชง้าน IBM® InfoSphere® DataStage® ซ่ึงเป็นซอฟตแ์วร์
ท่ีเร่ิมจะไดรั้บความสนใจ ซ่ึงหนา้ท่ีท่ีผูจ้ดัท าโครงงานไดรั้บมอบหมายคือ ศึกษาและอธิบายความสามารถ
ต่าง ๆ  ของ DataStage® ซ่ึงจะมีการน าเสนอกบัพนกังานท่ีปรึกษาเป็นระยะ ๆ  จนปรับปรุงใหเ้น้ือหาครบถว้น 
เท่าท่ีเวลาจะเอ้ืออ านวย 
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5.2 ปัญหาทีพ่บ 
1. ผูจ้ดัท าโครงงานนั้น ใชร้ะยะเวลาในการระบุสาเหตุของปัญหาค่อนขา้งนาน เน่ืองจากระบบท่ีศึกษา

มีความซบัซอ้น และระยะเวลาท่ีค่อนขา้งนอ้ย จึงท าใหไ้ม่เขา้ใจระบบไดดี้พอท่ีจะระบุตน้เหตุของปัญหาได้
ทนัที 

2. ไฟลบ์างอยา่งท่ีจ  าเป็นต่อการเช่ือมต่อฐานขอ้มูลนั้น ไม่ไดมี้มาพร้อมกบั IBM® InfoSphere® 
DataStage® และผูใ้หบ้ริการท่ีเป็นเจา้ของไฟลน์ั้น ก็ไดย้กเลิกการสนบัสนุนไปแลว้เน่ืองจากมี version ท่ี
ใหม่กวา่ ซ่ึงไม่สามารถใชก้บั DataStage® ได ้

 
 
 
 

5.3 แนวทางการแก้ไขปัญหา 

1. เพื่อเป็นการลดระยะเวลาท าความเขา้ใจระบบท่ีนั้น ผูจ้ดัท าโครงงานจึงไดเ้นน้ไปท่ีการศึกษา BI 
concept และเคร่ืองมืออ่ืน ๆ ท่ีใชใ้นการท าระบบข้ึนมา เพื่อช่วยใหก้ารท าความเขา้ใจระบบ สามารถเป็นไป
ไดอ้ยา่งรวดเร็วยิง่ข้ึน 

2. ในส่วนน้ี ทางผูจ้ดัท าโครงงานไดป้รึกษากบัพนกังานท่ีปรึกษาเพื่อหาแนวทางแกไ้ข ซ่ึงในกรณีน้ี
คือการใช ้Stage อ่ืนทดแทน 

 

5.4 ข้อเสนอแนะจากการด าเนินงาน 
ในกรณีท่ีเจอปัญหาท่ีมีความรู้สึกวา่แกไ้ขไม่ได ้ อาจจะเป็นเพราะขาดความรู้ท่ีจ  าเป็นต่อการท างานช้ินนั้น 
ดงันั้นนอกจากการหาความรู้และขอ้มูลดว้ยตนเองแลว้ ยงัจ าเป็นท่ีจะตอ้งมีความสามารถในการหาความรู้
พื้นฐานท่ีจ าเป็นอีกดว้ย ซ่ึงการปฏิบติัสหกิจนั้น ยอ่มไดเ้จอส่ิงใหม่ ๆ ท่ีไม่เคยไดพ้บเจอเป็นเร่ืองธรรมดา 
ดงันั้นการจะขอค าแนะน าจากพนกังานท่ีปรึกษาจึงไม่ใช่เร่ืองท่ีผิด แต่ก่อนจะถามอะไร ก็ควรเรียบเรียงและ
ตั้งเป้าหมายใหช้ดัเจนเสียก่อน เพื่อความรวบรัดชดัเจน 
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